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Notice

OMRON products are manufactured for use according to proper procedures by a qualified operator
and only for the purposes described in this manual.

The following conventions are used to indicate and classify precautionsin this manual. Always heed
the information provided in them. Failure to heed precautions can result in injury to people or
damage to the product.

DANGER! Indicates information that, if not heeded, is likely to result in loss of life or
serious injury.

WARNING Indicates information that, if not heeded, could possibly result in loss of
life or seriousinjury.

Caution Indicates information that, if not heeded, could result in relatively serious
or minor injury, damage to the product, or faulty operation.

OMRON Product References

All OMRON products are capitalised in this manual. The word “Unit” is also capitalised when it
refers to an OMRON product, regardless of whether or not it appears in the proper name of the
product.

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation
for anything else.
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Visual Aids

The following headings appear in the left column of the manual to help you locate different types of
information.

Indicates information of particular interest for efficient and convenient operation of the
product.

1,2,3... Indicates lists of one sort or another, such as procedures, checklists etc.

@ Represents a shortcut on the Toolbar to one of the options available on the menu of
the same window.

Other manual conventions are as follows:

Windows-based applications provide users with a number of different ways to perform one
operation. These are normally: from the application menu bar; using icons on a Toolbar; using
keyboard shortcuts; using the right-mouse button to display a context-sensitive menu; dragging
and dropping. Whilst recognising this, the manual provides user instructions employing the
Toolbar and right-mouse button only. Use of the application menu bar or keyboard shortcuts are
only included if no such alternatives exist.

Access to the CX-Server middleware is normally via other software applications, such as CX-
Programmer or CX-Protocol. Thisis noted in the manual by the term “invoking application”.

This manual refers to two distinct types of project: CX-Server projects and application projects.
A CX-Server project is defined in this manual. An application project is defined by the software
application invoking CX-Server.

0 OMRON, 2002

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or
otherwise, without the prior written permission of OMRON.

All copyright and trademarks acknowledged.

No patent liability is assumed with respect to the use of the information contained herein. Moreover,
because OMRON is constantly striving to improve its high-quality products, the information
contained in this manual is subject to change without notice. Every precaution has been taken in the
preparation of this manual. Nevertheless, OMRON assumes no responsibility for errors or omissions.
Neither is any liability assumed for damages resulting from the use of the information contained in
this publication.
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About this Manual

This manual describes the CX-Server application and its ability to control and monitor a range of
OMRON PLCs. It does not provide detailed information concerning the PLCs themselves, for this
information the commercial manual for the device must be consulted.

This manual contains the following chapters:

Chapter 1 - Technical Specification. This chapter describes CX-Server in general terms and
introduces the user to the relationship between CX-Server and associated products. It aso
provides details of the operating environment, minimum configuration and installation
procedures necessary for the satisfactory operation of CX-Server.

Chapter 2 - Introduction to CX-Server. This chapter describes the concepts on which CX-
Server is based including the definition of PLCs, points and groups.

Chapter 3 - Communications. This chapter describes the communications supported by CX-
Server

Chapter 4 - Import/Export Tool. This chapter describes the Import/Export Tool and its ability to
add datafrom CVSS and L SSfilesto a CX-Server project.

Chapter 5 - DDE Manager Tool. This chapter describes the DDE Manager and its ability to
read and update point data via CX-Server.

Chapter 6 - Performance Monitor Tool. This chapter describes the Performance Monitor Tool
and the procedures involved when monitoring communications.

Appendix - A Network Availability. The tables in this appendice indicate the network available
to each PLC device group. FinsGateway has no network availability and is not described.

Appendix B - PLC Memory Area. The tables in this appendice provide memory area details for
each device group.

Appendix C - Toolbars and Keyboard Shortcuts. The tables in this appendice summarise the
toolbars and keyboard shortcuts available from each component tool.

A Glossary of Terms and I ndex are also provided

War ning: Failure to read and understand the information provided in this
manual may result in persona injury or death, damage to the
product, or product failure. Please read each chapter in its entirety
and be sure you understand the information provided in the chapter
and related chapters before attempting any of the procedures or
operations given.
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CHAPTER 1
Technical Specification

This chapter describes the CX-Server software in general terms and introduces the user to the
relationship between CX-Server and associated products. It also provides details of the operating
environment, minimum configuration and installation procedures necessary for the satisfactory
operation of CX-Server.

CX-Server Software

CX-Server is a communications management system in Microsoft Windows for OMRON PLCs. It
provides facilities to maintain PLC device and address information and to communicate with
OMRON PLCs and their supported network types.

CX-Server consists of the following components:

Aswell as acting as a server for other OMRON software, CX-Server includes other customer tools:

¢ CX-Server DDE Manager tool. A tool for allowing transference of data between PLCs and a
client using DDE, for example Microsoft Excel.

¢ CX-Server Import tool. Thistool is used for addresses and PLCs defined using the CVSS and
LSS products. It allows definitions of addresses and PLCs to be used by importing them into a
CX-Server project file.

¢ CX-Server Performance Monitor tool. A tool for monitoring communications throughput and
for displaying CX-Server's current performance level (i.e. a check to see if CX-Server is
becoming overloaded).

CX-Server operates on IBM compatible personal computers with Pentium or better central
processors, including Pentium 11. It runs in a Microsoft Windows environment (Microsoft Windows
95, 98, Millennium, 2000 or XP and NT4.0 with Service Pack 5 or later).

CX-Server comprises various executables, Dynamic Link Libraries (DLLS) and components. In
order to use certain communication types (i.e. Ethernet, SYSMAC LINK, SYSMAC NET), some
settings must be configured prior to use — separate to the software installation. Refer to Chapter 3-
Communications for further details.

About this Manual

This User Manual acts as a reference for CX-Server by describing its various concepts and abilities.
It also provides the basics of using its dialogs and supplied utilities.

Caution This manual is referred to from other software that utilises CX-Server, for
instance, CX-Programmer, CX-Protocol, CX-Supervisor or CX-Server
OPC and CX-Server Lite. Subsequently, some topics contained in this
user manual may not be relevant.
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CX-Server comes with a context-sensitive online help system which is designed to complement this
manual and to provide a quick reference at any point while using CX-Server when the manual is not
to hand. This general help system uses a fast hypertext system which allows progressively detailed
information about any topic to be obtained by selecting keywords within the descriptive text.

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft
Windows and know how to:

use the keyboard and mouse;
select options from Microsoft Windows menus;

locate, open and save datafiles;
edit, cut and paste text;
¢ usethe Microsoft Windows desktop environment.

.
¢
¢ operate dialog boxes;
¢
¢

If the installed version of Microsoft Windows has not been used before, it is recommended that the
reader spends some time working with it using the Microsoft documentation before using CX-Server.

Features

CX-Server is the corner stone of the suite of applications collectively known as the CX-Automation
Suite. The CX-Automation Suite is not one system but software that has been designed to
dynamically evolve with every direction a manufacturer would like to take and to accommodate any
implementation, improvement, adaptation or extension of any form of control or data acquisitionin a
manufacturing industry.

The software suite has been developed to serve you with powerful yet comprehensible software that
builds and runs networks that simply control one machine or an entire manufacturing process. It
comprises the following:

¢  CX-Programmer
¢  CX-ServerlLite
¢ CX-Server OPC
¢  CX-Protocol

¢ CX-Motion

¢  CX-Supervisor

The CX-Automation suite isin itself highly adaptive. 1t completes the integration of process control
and business information systems, by applying one and the same basic network architecture. For the
user it means that data from both sources of information can be jointly reported in familiar
applications such as spreadsheets, in which they can be recalculated in existing layouts or processed
along usual spreadshest procedures.

Revision
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The architecture is based on standards that are widely maintained such as ActiveX and OPC (OLE for
Process Control) and standard interfaces such as COM, DCOM and ODBC/ADO This conformity
also means that you can use standard interfaces and standard software.

System Requirements

CX-Server operates on IBM compatible personal computers with Pentium |1 or better central
processor.. It runsin aMicrosoft Windows environment (Microsoft Windows 95, 98, Millennium or
2000 and NT4.0 with Service Pack 5 or later).

Note: CX-Server is not guaranteed to be compatible with computers running Windows
emulation (for example, Apple Macintosh).

The following configurations are the minimum system requirements for running CX-Server in
Microsoft Windows 95, 98, Millennium, 2000 or XP and NT4.0 with Service Pack 5 or later).

Minimum System Requirements

Minimum Specification Recommended Minimum Specification
Operating CPU Memory HDD Display CPU Memory HDD Display
System Type (RAM) Space Type (RAM) Space
Windows 95 Pentium 32Mb 100Mb 800x600 Pentium 64Mb 150Mb | 1024x768
Windows 98 | Class SVGA Class SVGA
Windows NT 133MHz 200MHz
(with SP 5)
Windows Pentium 64Mb 100Mb 800x600 Pentium 64Mb 150Mb | 1024x768
2000 Class SVGA Class SVGA
Windows ME 150MHz 200MHz
Windows XP Pentium 128Mb 100Mb 800x600 Pentium 256Mb 150Mb | 1024x768
Home Class SVGA Class SVGA
Windows XP 300MHz 600MHz
Professional

Use of a mouse is highly recommended, although all operations can be performed using the
keyboard. Refer to Appendix C for alist of keyboard shortcut commands.

The amount of RAM and hard disk space used depends upon the size of the PLC programs written —
approximately 1K per step.
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Communications Requirements

In order to use serial communication types SY SMAC WAY and Toolbus the following is required:

¢ RS232 connection via a standard serial port on the PC (COM1 etc.) or RS422 connection to a
422 serial board.

¢ Inorder to use SYSMAC LINK directly from the PC a SYSMAC LINK Network Service Board
and FinsGateway Version 3 or higher is required.

¢ Inorder to use SYSMAC NET directly from the PC a SYSMAC NET Network Service Board
and FinsGateway Version 3 arerequired. (Windows NT4 only)

¢ Inorder to use Controller Link directly from the PC a Controller Link Network Service Board
(wired or optical) and FinsGateway Version 3 or higher are required.

¢ In order to use Ethernet an Ethernet card, Windows Sockets software and TCP/IP must be
installed and correctly configured.

¢ Inorder to use an | SA board FinsGateway Version 3 or higher is required.

¢ Controller link PC NSB is supported using FinsGateway Version 3 or higher.

¢ SYSMACLINK PC NSB is supported using FinsGateway Version 3 or higher.

In order to use FINSGateway with the CLK/SLK PCI board in the Windows 98 or 2000 operating
system the appropriate drivers must be installed. These drivers can be found on the CX-Server CD
under: CX-ServeWDM\CLK (PCI)\ or CX-ServerWDM\SLK (PIC)\

Refer to Chapter 3- Communications for more information and the appropriate hardware system
manuals for full information about connecting and configuring these devices for the environment.

Installation

This describes the procedures involved in the installation of CX-Server on a standard workstation
running Microsoft Windows 95, 98, Millennium, 2000 or XP and NT4.0 with Service Pack 5 or later.

The software is supplied on CD-ROM and is installed easily from within Microsoft Windows. The
installation can be terminated at any point during the installation process.

If CX-Server is being installed as part of the CX-Programmer installation then on completion of the
CX-Programmer installation a number of dialogs will prompt for information concerning the
installation of CX-Server and its components.

Note:  If using CX-Server under Windows 95, DCOM95 isrequired for correct operation.
Thisisinstalled as part on the install process.
1,2,3... 1. Insertthe CD-ROM in the appropriate drive and select the Run option from the
Start pushbutton on the taskbar.
2. Click the Browse pushbutton and select the Setup.exe executable file in the
CX-Server directory or from the CD-ROM drive.

3. Click the OK pushbutton to start the installation then follow the on-screen
instructions.
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Starting CX-Server

CX-Server components are normally accessed from the invoking application. However, a number of
tools can be accessed as stand-alone tools from the windows Start menu (on the Microsoft Windows

taskbar).
.u"x- Performance Monitor tool.
=~ DDE Manager tool.
I ™

b:'-l » CX-Server Import / Export tool.

Help and How to Access it

CX-Server comes with a detailed context-sensitive help system. At any time while using the
software, it is possible to get help on the particular point that is currently being worked on, or on
general aspects of CX-Server. This system is intended to complement the manual, by providing
online reference to specific functions of the software and how to use them. The manual is designed
to provide more tutorial information and discuss the various facilities offered by CX-Server.
Context-sensitive help;

Help Index (available on the Help menu);

Help Contents (available on the Help menu);

About (available on the Help menu);

Status Bar tool button tips.

* & & o o

Help Topics
Select the Help Contents option on the Help menu. The Help system provides a standard look-up
dialog under the Contents tab showing the contents of the CX-Server Help file. Click on an item to
read the associated information.

Index
Use the following procedure to retrieve online help from the Index tab of the Help Topics dialog.

1,2,3... 1. SelecttheHelp Index option from the Help menu.
2. Enter atext query into the first step field. The second step field is refreshed
according to the query entered in the first step field.
3.  Select an entry in the second step field and select the Display pushbutton, or
double-click on the index entry.

4. If an entry is linked to two or more topics, the names of the topics are
displayed in the Topics Found dialog. Select a topic and choose the Display
pushbutton or double-click on the topic.
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Find
Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog.

1,2,3... 1. SelecttheHelp Index option from the Help menu.

2. Select the Find tab.

3. Enter atext query into the first step field. The second step field is refreshed
according to the query entered in the first step field. Previous text queries can
be retrieved by selecting from the drop-down list in the first step field.

4. Select a word that matches the query — some words may be automatically
selected. More than one word can be selected by pressing Shift and selecting
another word to extend the selection, or by pressing Ctrl and selecting another
word to add to the selection. The third step field is refreshed according to the
word or words selected. The number of topics found are shown at the bottom
of the dialog.

5. Select atopic from the third step field and select the Display pushbutton, or
double-click on the topic from the third step field. Select the Clear pushbutton
to restart the find operation.

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button.
Refer to Microsoft Windows 95 documentation for further information.

Context-sensitive Help

CX-Server supports the use of context-sensitive help. The relevant online help topic is provided
automatically by selecting the current area of the display responsible for carrying out those actions.
Select the F1 function key to retrieve context-sensitive help. Some dialogs include a Help
pushbutton when F1 cannot be accessed.

About CX-Server

Each CX-Server component contains an About option on the Help menu. The About CX-Server
dialog supplies technical reference information about that component such as version and copyright
information. It also contains the version number which is required for obtaining technical support.

Use the following procedure to view the About CX-Server dialog.

1,2,3... 1. Select About fromthe Help menu.

2. The About box is displayed. It provides a copyright statement and version
number of the component or tool within CX-Server.

Status Bar

The Status Bar is displayed at the bottom of many of the CX-Server component and tool windows. It
provides several helpful pieces of information while programming:
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¢ Instant Help. A brief message appears in the Status Bar as menu commands and buttons are
selected.
¢ Online Satus. The online or offline status of the PLC.
¢ PLC Mode. When connected to a PLC, this shows the current PLC mode. Connection errors are
also displayed here.
¢ Connected PLC and CPU Type. The currently connected PLC and associated CPU can always

be referenced in the status bar.

The CX-Server Status Bar can be enabled and disabled from many components and tools by selecting
the Status Bar option from the View menu.

Technical Support

If the ingtallation instructions for this have been followed (refer to ‘Installation’ above), no
difficulties should be encountered. However, if there is a problem, contact Customer Services.

If a problem occurs, check that it does not relate to a fault outside CX-Server. Check the following:

* & o

¢

The PC isworking correctly.

The PLC isworking correctly.

The communications system is set up correctly.
Theerrors are cleared in the PLC.

When Customer Services need to be contacted, keep the details shown in the following table to hand.
A clear and concise description of the problem is required, together with the exact text of any error

messages.

Note:  Usethe About box to obtain the version number of the component.
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Customer Services Required Information Table

Version number of CX-Server
component or tool:

Serial number of the software:

Operating system and version
number:

Language of operating system:

PLC type, model and CPU
details:

Type of communications in use:

Serial

Toolbus

SYSMAC LINK

SYSMAC NET

Device NET

Controller Link

Ethernet

Nature of the problem:

Steps taken to reproduce
problem:

Other comments:
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CHAPTER 2
Introduction to CX-Server Projects

This chapter describes how data is identified within CX-Server projects (in terms of PLCs, points and
groups). It also describes the CX-Server functions available for the purposes of configuring PLCs
and points within a CX-Server project.

CX-Server Projects

CX-Server is a middleware package which allows other software to access OMRON automation
devices (PLCs, temperature controllers, Memory Card Writer and PROM Writer) through various
connection types. In order to co-ordinate these communications, it handles information detailing the
PL C devices attached to the PC and the information being accessed on each device.

Such information is held in a CX-Server project file with a.CDM extension. Thisfile contains al of
the information about the PLCs, which CX-Server can connect to and the addresses of interest in each
PL C which may be accessed.

Each CX-Server project file is separate and is similar in concept to a document. CX-Server can deal
with many CX-Server project files at a time, although often only one CX-Server project is used by
the client software at any time.

A number of steps are involved in the setting up of a CX-Server project. At ahigh-level, these can be

regarded as:

¢ ldentifying the PLCs which the PC isto communicate with;

¢ ldentifying the addresses (points) within the PLC which are to be accessed during
communications;

¢ Establish the type of network to be used.

CX-Server Project Concepts

CX-Server projects consist of PLCs, Connected Devices, Networks and Points. The following
paragraphs describe the of PLCs, Networks and Points into a CX-Server project and introduce the
Project Editor. Specific setup of PLCs and Networks are described in Chapter 3 - Communications.

PLCs
A CX-Server project file contains a list of PLCs which are (potentially) connected to the PC. These
PLCsdo not really have to be connected unless communications with them are to occur.
Each PLC has the following attributes:
¢ Device Name. A unique name with the CX-Server project file so that the PLC can be easily
referenced (for example, ‘ PumpRoom1’).

¢ Comment. A free-form long comment which is only used for information by the user that is
attached to the unique device name.

Revision 1.7 Page 9



OMRON

CHAPTER 2 — Introduction to CX-Server Projects

Points

¢ Device Type. The PLC devicetype (for example, CV500).

¢ Connection Type. How to connect to the PLC and the address of the PLC on the chosen network
(for example, direct one-to-one connection or via a gateway PLC, one that is already defined in
the CX-Server project).

¢ Type Options. A list of options which may be present on the PLC (for example, the amount of
user-memory, clock, EM configuration and CPU type).

¢ Connection Options. A list of options which may be available on the chosen network (for
example, the speed of communication on SYSMAC WAY, Toolbus, Modem configuration, or
Network or Node configuration details).

A full description of the communications possibilities for C-series PLCs, CV-series PLCs and CS1-
series PLCsis provided in Chapter 3 - Communications. Host Link Port and Peripheral Port settings
are made via the PLC Setup Component, refer to PLC Tools User Manual Chapter 4 - PLC Setup
Component. Once the network has been defined and configured, it can be tested to ensure that
messages are being transmitted correctly.

The PLCs selected also affect which other setup procedures need to be performed; for example, the
CV-series and CS1-series requires setting up the 10 Table and using the PLC Setup Component to
establish specific PLC characteristics. In addition it is possible to set up to three levels of networks
and to communicate with these networks, the initial, direct connection must be to a PLC acting as a
gateway. To ensure that messages from the PC reach the end connection PLC, the gateway PLC
must contain the routing information which identifies this PLC. Procedures for configuration of the
network is provided in the PLC Tools User Manual Chapter 8 - CX-Net Network Configuration Tool,
Chapter 10 — Datalink Editor, Chapter 11 — Routing Tables.

Connection to the PLC requires the specification of the type of communications interface to be used
to connect to the PLC. CX-Server supports two methods of communication: serial communications
and network communications. Serial and network communications can be made using the
Connection Type dialog athough these are dependent upon the type of PLC being communicated
with.

The CX-Server project file also contains a list of addresses which may be accessed in the defined
PL Cs, each address being contained inside a point. Each point has the following attributes:

¢ Name. A unique label within its group so that the point can be easily referenced, similar to
foldersin Microsoft Windows Explorer (for example, ‘ Conveyor Position’).
Comment. A free-form long comment used only for reference by the user.
Address. The location of the information inside the configured PLC:
¢ including the PLC (by name, matching the label of the defined PLC),
¢ address (for example, ‘D0’),

¢ the number of elements (for example, ten elements for ten channels) and type (for example,
bit, channel, floating point).
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Points are stored within the CX-Server project filein ahierarchical group structure. New groups may
be added to the CX-Server project at any level of the hierarchy tree. Groups act as container objects
(as folders contain files) for relevant points within a CX-Server project. Similar points may be
banded together and stored within these groups.

Editing a CX-Server Project PLC List

The Edit Project dialog alows the PLC or Points information in the currently opened CX-Server
project to be modified, deleted or added. A CX-Server Project PLC list can be edited from either the
Import/Export tool or the CX-Net tool by selecting the appropriate .cdm file and then selecting Edit
from the Project menu. Alternatively from the Project Editor right click on Devices and select the
Properties option or select Properties from the File menu.

Alternatively from the Project Editor right click on Devices and select the Properties option or select
Properties from the File menu.

Click on the PLCs Setup pushbutton in the edit project dialog to edit the CX-Server project PLC list.

The Device List dialog is subsequently displayed; this is the central point for adding and setting up
PLCs and lists al currently defined PLCs in the open CX-Server project file, their type, network
details and any comments associated with each device.

Device List - EXAMPLE.CDM E
— Configured Device
M ame | Device | I ebwark, |
B C200HX-Z S C200HA-Z SYSMAL WY
B C315wY C51H SYSMAC Wiy
Cv1moo SYSMAL WY
Add Bename | Delete |

Device: IE'WDDD j Settings... |
Metwork: |5YSMAL Wity ]| _ Settings..|

Comrment
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fl Thisicon denotesaPLC.

ff3 Thisicon denotesaPLC also used as a gateway PLC.

/&,  Thisicon denotes that the device is open for communications. A device list cannot
be opened whilst open for communications.

&, A PLC device cannot be deleted or have its network or device settings altered if it is
open for communication (i.e. active). It cannot be modified in any way if the CX-
Server project has been opened as read-only. It cannot be deleted or its device type
changed if it is acting as a gateway.

Adding a PLC

The Device List dialog also permits addition of new PLCs to the open CX-Server project. Use the
following procedure to add aPLC.

1,2,3... 1. Click on the Add pushbutton in the Device List dialog. An entry is made in
thelist of Configured Devices.

2. Enter a name in the PLC Name field. This has a maximum length of 32
characters and must be unique within the currently open CX-Server project
file; it must not contain any of the following characters: : / \ : ; , 2 * & I ©
but can contain spaces and international characters. The PLC Name field is
case sensitive, i.e. if aname is entered in upper case which aready exists in
lower case (and vice versa), anew PLC is created.

3. Select options for the Device field and Network field for the new PLC. Thelist
of Configured Devices is updated. Clicking outside this new entry resultsin a
confirmation dialog being displayed. If required select the associated Settings
pushbutton to refine the Device Type Settings and Network Settings. Refer to
Chapter 3 - Communications for further information.

4. If the Close pushbutton or another PLC name is selected, a dialog appears
asking for confirmation of the changes just performed; select the Yes
pushbutton to remove the dialog and save the new PLC. Select the Cancel
pushbutton to abort the operation.

Note The default device name selected from the Add pushbutton in the Device
List dialog is unique within the CX-Server project, for instance
‘NewPLC1'.

Deleting a PLC
The Device List dialog also permits deletion of a PLC from an open CX-Server project. Use the
following procedure to remove a PLC.

1,2,3... 1. Highlight the required PLC name in the Device List dialog and select the
Delete button. A dialogis displayed asking for confirmation of the deletion.
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2. Select the Yes pushbutton to confirm the deletion or the No pushbutton to
cancel the operation.

&, Itisnot possible to delete a device that is open for communications, indicated by the
Device Openicon, asit cannot be opened.

ﬂs It is not possible to delete a device being used as a gateway device, indicated by the
Gateway Deviceicon.

Renaming a PLC

The Device List dialog allows the name of a PLC to be atered. Use the following procedure to
renamea PLC.

1,2,3... 1. Highlight the required PLC name in the Device List dialog and click on the
Rename pushbutton.

2. Typeinthe new name, to a maximum length of 32 characters.

If the Close pushbutton or another PLC name be selected, a dialog appears asking for confirmation of
the changes just performed; select the Y es pushbutton to remove the dialog and save the new name.
Select the Cancel pushbutton to abort the operation.

Editing CX-Server Project

Points and groups within a CX-Server project can be edited via the CX-Server Project Editor whichis
accessed from the Import/Export tool or the DDE Manager. The Project Editor allows new points,
groups and devices to be added, modified to and/or deleted from the CX-Server project.

A CX-Server Project can be edited by selecting Edit from the Project option on the menu bar of the
Import / Export tool or by opening / editing a project in the DDE Manager. The option is not
available to all tools and components and is further unavailable unless a CX-Server project has been
opened or created.

Click on the Points Setup pushbutton in the edit project dialog to edit the CX-Server project. The
information displayed includes the following:

A ‘devices view showing al devices configured in the CX-Server project and each
device available memory areas. The complete group hierarchy of the CX-Server
project, and details of the points (in their memory areas) within the CX-Server
project.

= A ‘points’ view showing details of the points (within their groups).

Comments (name and address comments) relating to a point are displayed when the appropriate
element is highlighted.

A point represents an input or output data area within a PLC; it can refer to a single bit of data
(representing for example, “Hopper empty”, “Activate Reject Solenoid”), or to a multiple bit word
(representing for example, “Process Temperature”).
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Associated with each point is a name and address indicating its position within a PLC and a PLCs
memory; comments can aso be entered against a point’s name and address.

The information held at a point can be read or updated by CX-Server. A third party can also access
this point data by establishing alink between that and the PLC.

Note More than one point can have the same address, any comment entered
against this address applies to al points at this location. Comments
entered against the point name are unique to that point only. Points do not
have to have a name, however, if anameis supplied it must be unique.

To access the Project Editor, open the CX-Server Import/Export tool and open or create a project.
Then from the Project menu select Edit, this opens the Edit Project dialog. In Edit Project click the
Points: Setup button.

ig Project Editor - E\\Program Files'OMRONICX-Serverialan Test.cdm
File Edit %iew Toolz Help
B|ale] &[5|@] e x|l 2w ]E
E:\Program Files\OMROMACS-Server’ | Name | Type | Address | Carnmert |
Eﬂ Devices [(dGmoup1 Group
3 Group 2 Group
£ New Paint 1 Paint PLCA A MISH
€2 New Point 2 Paint PLCA AUSH
i DM
Mew PLC 2
5@
=1 Group 1
&[] Group 1-0
in[ 7] Group 1-1
-] Group 2
| | |
[ [\ |Paints |4 items] r

The status bar provides instant help.

The Project Editor can be manipulated in a similar manner to Microsoft Windows Explorer. The left
pane displays the content of the project in terms of Devices Networks and Points.

#- To expand the hierarchy in the left pane, select thisicon.
El To collapse the hierarchy in the left pane, select thisicon.

To view the content of a particular branch in the hierarchy, double-click on theitem in the left pane.

Select the Up One Level button from the toolbar to traverse back through the
hierarchy toward the root.
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pane as large icons.

_l Select the Small Icons button from the toolbar to display the content of the right
pane as small icons.

ii-| Select the List button from the toolbar to display the content of the right pane as a
list.

Select the Details button from the toolbar to display the content of the right pane
with associated details.

The Toolbar and status bar can both be turned on or off. Select Satus Bar from the View menu to
control the display of the status bar. Select Toolbar from the View menu to control the display of the
Project Editor toolbar.

El Select the Large Icons button from the toolbar to display the content of the right

If points are displayed in the right pane, the view can further be modified by setting certain
preferences.
¢ Showinginvalid points;
¢ Showing open points/ PLCs,
¢ Automatic resizing of list column.
Use the following procedure to set point preferences.

1,2,3... 1. Click onthe Pointsicon in the left pane to open the points view of the editor in

the right pane.
2. Select Options from the View menu. The options dialog is displayed.

3. Amend point preferences from the General tab. Select the OK pushbutton to
complete the operation. Select the Cancel pushbutton to abort the operation.

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows
online help.

#| Tosave changes and close the Project Editor, select the Close button in the title bar.

Adding a Group

Points are saved within groups in a CX-Server project. When a CX-Server project isinitially created
it contains the root level group only. Groups can be created within a CX-Server project in
hierarchical order from the root level. Points are saved within the root group or specified subsidiary
groups within the hierarchy, similar to folders and files within the Microsoft Windows Explorer.

The Add Group dialog adds a new group under the currently selected group.

1,2,3... 1. OpentheProject Editor, click on the branch of the CX-Server project hierarchy
to which the group is to be added; for instance the Points root branch and add a
group.

gl 2. Select the Add Group button from the toolbar. The New Group ‘n’ will be
added to the tree structure in the appropriate position.
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Renaming a Group

To rename a group, select the group followed by the Rename button in the toolbar.
Alternatively select Rename from the File menu option. or right click on the group
and select the Rename option.

The new group name has a maximum length of 32 characters and must be unique
within the group that it is being created. It must not contain any of the following
characters:: / \ :; ,?2* & ! “.

The group name field is case sensitive. For example, if aname is entered in upper
case which already existsin lower case a new group name will be allowed.

abl

Adding a Point

The Add Point dialog allows a new point within the currently open CX-Server project to be created
and its name and address to be entered. Use the following procedure to add a point.

1,23..

b=

1.

N

Open the Project Editor, click on the Points branch in the tree.

Select the Add Point button from the toolbar. The Add Point dialog is
displayed.

Select the Logical Tab and enter the new name in the Name field; this has a
maximum length of 32 characters, it must be unique, and must not contain any
of the following characters: / \ : ; , ? * & ! “ but caninclude an existing
path to indicate the group to which it belongs (if it is to be added to a group
other than that indicated above the name). A name is optional, but if supplied
must be unique.

A comment can only be added to a point if a point name has been supplied.
Enter text in the Comment field to be associated with the point name. This
field isoptional and is used simply for reference purposes.

Select the Physical Tab and select the PLC to be associated with the point in
the PLC field. Thisfield is mandatory but can be set to ‘None’ until a correctly
configured PLC is added to the CX-Server project.

Enter the data location in the Data Location field identifying the area of
memory to which this address applies; this value is dependent upon the type
and configuration of the PLC and is mandatory if a PLC has been selected.
Memory Area and Start Address must be supplied, for instance, ‘DO’ for a CV-
series and CSl-series PLC or ‘DMO’ for a C-series PLC. Refer to Appendix B
PLC Memory Areas for acomplete list of valid PLC memory areas and ranges.

Enter the number of elements indicating the number of address units which
dtart at the specified data location (i.e. the size of an array of addresses, for
instance, ten for ten channels) in the Elements field. Thisfield defaultsto 1.
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10.

Note

Select the Internal Data Type in the Internal Data Type field, identifying the
format of the data held at the PLC address (e.g. BCD or binary, WORD or
double WORD). This alows CX-Server to automatically convert the PLC
specific format of the data to a common format which the PC can use.

Select the Command Modifier required to access this address in the Command
Modifier field. The modifiers available depend upon the data location chosen.
An example of a modifier is Forced Set which forces a data location to be held
with given data, overriding the PLC program's usage.

Select the OK pushbutton to save the point details or the Cancel pushbutton to
discard the new point.

The fields in the Address chapter of the dialog are only enabled when a
PLC has been selected and the values available in these fields (if any) also
depend upon the PLC chosen.

If several points are to be added at a time, the Leave Box setting should be checked, this allows the
dialog to stay active after the Add pushbutton is pressed. The fields remain populated with the
previous point’s settings allowing further modification. Select the Close pushbutton to remove the

dialog.

A point can have a name and/or an address. It does not need to have both.

Points with valid addresses assigned are marked by an icon according to the Internal Data Type set as

follows:

Internal Data Type Icon Internal Data Type Icon

No type defined F:) Single Word Unsigned BCD

Bit Double Word Unsigned BCD

Signed Character Binary

Quad Word Unsigned BCD

Unsigned Character Binary

Single Word Signed BCD

Raw Character Binary

Double Word Signed BCD

Single Word Unsigned Binary

Quad Word Signed BCD

Double Word Unsigned Binary

Double Word Float

Quad Word Unsigned Binary IEEE Float
Single Word Signed Binary Complex
Double Word Signed Binary LReal

Quad Word Signed Binary

Bl ) W o

Points with an invalid PLC address assigned to them are indicated by the associated icon.
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Editing a Point
The Edit Point dialog displays the current configuration for a selected point allowing these details
(including the name) to be amended. The Edit Point dialog operates in the same manner as the Add
Point dialog described above.
1,2,3... 1. Selectthe point to be edited.

2.  Select the Properties button from the toolbar. The Edit Point dialog is
displayed. Thisisidentical to the Add Point dialog.

&, A point's address or PLC cannot be modified if it is currently active, i.e. open for
communications, indicated by the Device Open icon in the Project Editor.

Deleting a Point or Group
Use the following procedure to delete a point or a group.

1,2,3... 1. Highlight the point or group to be deleted
il 2. Select the Delete button from the toolbar to delete the point or group.

A confirmation dialog is displayed provided this option has been set in the Options dial og.

&, Any points or groups contained within a group being deleted are also removed,
unless any points within the group or children of the group are open for
communications, in which case the points and the groups they are contained within
are not deleted.

Points which are currently active cannot be deleted.

Note The root group cannot be deleted.

Moving and Copying Points and Groups

The Project Editor allows standard Microsoft Windows drag and drop procedures permitting points
and groups to be copied or moved within the Points group.

Moving is achieved by clicking on an item and then dragging the mouse to the item’s new position.
A confirmation dialog is displayed. Copying is similar except that the Ctrl key must be kept
depressed.

Use the following procedure to copy or move information from or in the Project Editor.

1,2,3... 1. Selectanitemin theright pane of the Project Editor, for example apoint. More
than one item can be selected by pressing Shift and selecting another item to
extend the selection, or by pressing Ctrl and selecting another item to add to the
selection.

£ || 2. Select the Copy button from the toolbar to copy the item, or the Cut button
from the toolbar to move the item.

3. Select an area in the Project Editor to copy or move the items to, for instance
copying a point into a new group.
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El 4. Select the Paste button from the toolbar to paste the item. A Paste operation
can be performed several times without copying again.

Adding a Device

The Project Editor also permits devices to be added into the CX-Server project as an alternative to the
Device List (refer to Chapter 2 - Adding a PLC for details). Use the following procedure to add a
device.

1,2,3... 1. OpentheProject Editor, click on the Devices branch in the tree.

@l 2. Select the Add PLC button from the toolbar. The Change PLC dialog is
displayed. Refer to Chapter 3 - Communications for details regarding device
setup.
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CHAPTER 3
Communications

This chapter describes the communications options available to CX-Server and is confined to
software aspects and the associated CX-Server interface; more detailed information relating to each
hardware product isto be found in its associated OMRON commercial manual.

Supported Communications

Communications between CX-Server and target PLC's are achieved by a combination of different
network connection types. SYSMAC WAY, SYSMAC LINK, SYSMAC NET, Controller Link,
Toolbus, Ethernet, Memory Card Writer, PROM Writer, and Modem. Each network connection has
different capabilities. SYSMAC NET is specialy suited for medium to large scale systems where
connecting PLCsto computersisincluded. SYSMAC LINK provides the necessary capabilities of an
industrial network: SYSMAC WAY operates at a much simpler level, its primary functions are for
monitoring and diagnostics. SYSMAC WAY and Toolbus both provide Modem connection
facilities.

The combination employed depends upon the requirements of the system. The network connection
types used will determine the maximum speed of data transfer rates and frame lengths that can be
used. When the PLC network is first set, the default connection should be used to determine the
maximum frame length and baud rates.

CX-Server controls communications with target PLCs, formats messages into the correct protocol
and then transmits them to the device (normally a PLC but it can be a memory card); messages are
also received from the PLC containing data to be transmitted to applications, for example CX-
Programmer, CX-Protocol and CX-Net Network Configuration tool. The type of messages
transmitted include requests to update point data or to download programs.

When a PLC is being configured, as discussed in Chapter 2 - Introduction to CX-Server Projects,
CX-Server automatically provides a list of the possible network types associated with the selected
device; PLC Tools User Manual Chapter 8 - CX-Net Network Configuration Tool describes how to
create the actual PLC/network communications links (including the creation and modification of
associated Routing and Data Link Tables).

Device Setup

PLC Settings

Each CX-Server project can contain a list of devices. A device can be a PLC which can be
configured to map on to a physical connection (either directly or via an existing gateway connection).
A correctly configured connection allows connections to the PLC.

Each device added to the CX-Server project must be given a unique name within the CX-Server
project file; the device type and network connection should also be given, for example: ‘CV500,
‘SYSMAC WAY".
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The Change PLC dialog allows a new PLC to be added to the CX-Server project and its device type
and network settingsto be defined. 1t isalso used to edit existing PLC details. It isaccessed from the
invoking application or from CX-Server CX-Net tool. It can also be accessed from the Project editor
by expanding the device list, selecting the appropriate PLC and then clicking the properties button in
the toolbar or selecting Properties from the File menu.

Note

A PLC cannot be created unless a CX-Server project has been opened.
Whilst PLCs are added to the CX-Server project via this dialog, the CX-
Net Network Configuration Tool must be used to set up routing tables for
those PLCs acting as a gateway. Refer to the PLC Tools User Manual
Chapter 8 - CX-Net Network Configuration Tool for further information.

Device Hame
|isnPLC]

Device Typs
EE =] Gemege.

Mk Tipe
B x| Gettngn. |

Commant

[ ] ceme | Hel

Use the following procedure to change the PL C settings:

1,23. 1

Enter aname in the Device Name field. A device name must consist of no more
than 32 characters and must be unique.

Select the device type of the PLC in the Device Type field. If the device
requirement does not appear in the list then CX-Server does not support it.

Further configure the device type (e.g. CPU number) by selecting the Device
Type Settings pushbutton. Refer to Chapter 3 - Device Type Settings for
further details.

Select the network type of the PLC in the Network Type field. This list may
include other PLCs in the CX-Server project that can be used as gateway
devices, depending upon the device type chosen. A full list of connection types
are provided below.

Further configure the network settings (e.g. node number) if applicable by
selecting the Network Type Settings pushbutton. Refer to Chapter 3 - Network
Communications (End Connection) for further details.
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6. Optionaly, enter acomment relating to this unique PLC in the Comment field.
7. Select the OK pushbutton to save the new PLC or the Cancel pushbutton to

abort the operation.
Note The Device Name must not contain any of the characters: : / \ @ ; , ? *
& ! * but may include spaces and international characters. The Device

Name is case sensitive, i.e. if anameisentered in upper case which already
exists in lower case, a new PLC is created. The contents of the Network
field depend upon the device type settings of the new PLC. The Device
Type Settings pushbutton is disabled for the following devices. C20,
FinsGateway, Memory Card Writer and Programmable Read Only
Memory (PROM) Writer, since these devices do not have options. Any
PL Cs which have been set up and can act as a gateway device appear in the
Device Typefield.

A full list of connection methodsis as follows:

SYSMAC WAY.

Toolbus. Toolbus on the CSl-series PLCs alows CX-Server auto-baud rate detection up to
115,200 bps. Toolbus on the CS1-series PL Cs supports full n clients and n destinations.

Modem via SYSMAC WAY. Modem is supported through SYSMAC WAY communications via
Windows TAPI configuration.

Modem via Toolbus. Maodem is supported through Toolbus communications via Windows TAPI
configuration.

Ethernet via TCP/IP. Ethernet is only supported for CSl-series PLCs, CV-series PLCs and
C200HE/GIX/E-ZIG-Z/X-Z series PLCs. All Ethernet connections now also support full n
clients and n destinations via CX-Server Ethernet driver. CX-Server also utilises FinsGateway
Version 3 Ethernet driver if the required PLC connection UDP port is locked open by
FinsGateway active running services.

Controller Link for OMRON NSB. Controller Link is supported through FinsGateway Version 3
when installed via CX-Server installation and services are activated. CS1-series PLC Optical
Controller Link is supported via FinsGateway Version 3 when Controller Link isinstalled.

SYSMAC LINK for OMRON NSB. SYSMAC LINK is supported through FinsGateway Version
3 when installed via CX-Server installation and services are activated.

SYSMAC NET for OMRON NSB. SYSMAC NET communications are supported on Windows
NT only through FinsGateway Version 3 when installed via CX-Server installation and services
are activated.

FinsGateway CPU unit connection and Gateway connection combinations.

CSl Board for Omron CS1 PCI board. PCI Board is supported through FinsGateway version
3.12 when installed via CX-Server installation and services are activated.
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Device Type Settings

The Device Type Settings dialog allows further configuration of the selected PLC. Thisisimportant
since the behaviour of the PLC depends upon details such as CPU type (e.g. the network options
available to a C200HS require CPU31 or CPU33 setting to be specified). Device type settings cannot
be adjusted for an open PLC or a gateway PLC.

The General tab of the Device Type Settings dialog allows:
Selection of CPU Type;

Allocation of Program Memory or protection from writing;
Allocation of Expansion Memory or protection from writing;
Allocation of File Memory or protection from writing;
Installation of a Timer/Clock.
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When settings cannot be selected, the PLC is fitted with the standard settings as shown on the Device
Type Settings dialog and cannot be reconfigured. Similarly, if Expansion Memory cannot be selected
for CV-Series PLCs, EM memory cannot be configured.

In each instance, availability of CPU Type and memory depends upon the device type selected (and
also the amount of expansion memory purchased for the PLC). Changing CPU type automatically
changes the amount of memory available on some devices.

For SRM1 PLCs, only CPU Type can be selected.

For CV-series PLCs, CSl-series PLCs and IDSC, File Memory alows selection of the amount of
EPROM or EEPROM. A Timer/Clock can be installed.

Revision 1.7 Page 24



OMRON

CHAPTER 3 — Communications

Defin

ing Connections and Gateway PLCs

It is possible to communicate with PLCs which are not directly connected to the computer via PLC
network configuration and gateway abilities of PLCs. Generally, a directly connected PLC or the
network NSB as a gateway is used to route to the required PLC by use of its routing table and
networking capability. In order to specify the link information, a network type (e.g. SYSMAC
LINK) and PLC addressing information is needed (i.e. target network, node and unit).

Connection can be directly made to any PLC type. Direct connections are established with SY SMAC
WAY, Toolbus, Modem, Ethernet through a network card or SYSMAC NET, Controller Link or
SYSMAC LINK viaan OMRON NSB.

It is also possible to gateway from a direct connection on to another type of network that cannot be
connected to directly.

PC CY-Series PLC CS1-Series PLC

.
= Ethernet ﬁ i i Coantroller Link [ﬁ(}jn‘trg"er Lirk
Metweork 24 Metwork #5

Unit Mode #32

Use the following procedure to define a gateway connection.

1,2,3... 1. OpentheChangePLC diaog.

2. Select the Gateway PLC (i.e. the direct connection). If necessary configure the
CPU type by selecting the associated Settings pushbutton.

3. Select the Network type and click on the associated Settings pushbutton. The
above exampl e uses Ethernet as the network.

4. The Network Settings dialog is displayed. Set up the address and Node number.
For Ethernet, also enter the I P address.

5. Select the OK pushbutton to proceed from the Network Settings dialog.
6. Select the OK pushbutton to proceed from the Change PL C dialog.
Use the following procedure to define atarget connection.
1,2,3... 1. Add a PLC Device to the CX-Server project. The Change PLC diaog is

reopened. Select the PLC type for the target PLC. If necessary configure the
CPU type by selecting the associated Settings pushbutton.

2. Select the PLC to be used as the Gateway PLC from the list in the Network Type
field and click on the Settings pushbutton.

3. The Network Settings dialog is displayed. Set up the Source Network and
Destination Network and Node number.

4. Select the OK pushbutton to proceed from the Network Settings dialog.

5. Select the OK pushbutton from the Change PLC dialog to complete the
operation or the Cancel pushbutton to abort the operation.
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Serial Communications (Direct Connection)

The computer involved in establishing communications has at least one serial (RS232) port; the first
port is normally called COM1. If in doubt check the configuration of your PC. Only a single PLC
can be connected to an RS232 port.

For CSl-series PLCs, if Toolbus is being used as the direct connection, multiple destinations are
permitted.

To establish aserial connection to several PLCs, Link Adapters are required that convert from RS232
to R$422. Link Adapters would be connected in the serial line between the computer and the PLC or
between the remote Modem and the PLC. Multiple connections are permitted from an RS422 port.

If problems are experienced when making a serial connection, check the serial port on the computer
is enabled and that a mouse driver is not loaded or connected to the same port.

For PLCs with direct serial connections on the CPU, default communications settings can also be set
by changing the DIP switches on the front of the CPU. The default protocol settings are 9,600 baud,
7 data bits, even parity and 2 stop bits. Older PLCs have a default baud rate of 2,400. For PLCs not
supporting this feature, settings are configured via the PLC Setup component. Refer to the PLC
Tools User Manaul Chapter 4 - PLC Setup Component for details of the PLC Setup component.

SYSMAC WAY

SYSMAC WAY provides a simple means of connecting a computer to a PLC for monitoring and
diagnostic purposes. It has a slower transmission path than SYSMAC LINK, SYSMAC NET,
Controller Link or Ethernet.

Communications are achieved by either:

¢ Employing the RS232 serial communications interface for communicating with individual PLCs.
¢ Employing the R$422 interface for communicating with multiple PLCs.
The following connections are required:

¢ RS232 connection via a standard serial port on the computer (COM1 etc.)

or
¢ RS$422 connection to a 422 seria board.

These connections can also be made via a Modem. Refer to standard Microsoft Windows
documentation for details on Modem configuration and setup.

The Driver tab of the Network Settings dialog allows the configuration information to be entered; this
information ensures that data is transmitted correctly over the network.
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Use the following procedure to apply Network Settings.

1,23. 1
2.

Note

Toolbus

Click on the associated Settings pushbutton in the Change PLC dialog.

In the Network tab, check the Unit No, usually 0 for connecting to asingle PLC
or the multi drop number for an RS422 connection.

In the Driver tab, check the port on the computer for connection to the PLC and
enter it in the Port Name field.

Select the Baud Rate, Parity, Data Bits and Sop Bits from the drop-down lists
available for the selected port.

For the Modem tab, refer to Microsoft Windows documentation.
Select the OK pushbutton to save these settings, or select the Cancel
pushbutton to abort the operation.

For CSl-series PLCs, SYSMAC WAY dip switch five on the front panel
must be set to ‘OFF'.

Toolbus operates in a similar manner to SY SMAC WAY . The connection is made to aPLC using its

peripheral port.

The following connection is required:

¢ RS232 connection via a standard serial port on the computer (COM1 etc.) using either CIFO1 or

CIF02 cable.
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The Driver tab is similar to that belonging to SY SMAC WAY ; however, for some PLCs fixed values
are entered and these cannot be altered (see table below). The SC1-Series PLC Toolbus
configuration ensures successful connection to the PLC every time, independently of the rate
specified by the user provided the Auto Baud Rate Detection setting has been checked.

PLC Fixed Data Bits Parity Stop Bits
CS1/CJ1 Series Yes 8 None 1
CVICVM Series Yes 8 Odd 1

C Series No --- --- ---
CPM1/CPM1A --- --- --- ---

SRM1/SRM1-V2 .- - - .
CPM™*/CPM2*-S* --- --- --- ---
CQML/CQM1H

Serial Networks

When connecting a computer to a serial network of PLCs, each PLC needs to be configured so that it
has a different Unit number. The Unit number for C-series PL Cs should be configured as follows:

CPU-mounted Host Link unit:

DIP switches on back of unit

Rack-mounted Host Link unit:

Rotary switches on front of unit

Direct CPU RS232 port:

Internal DM settings

Direct CPU Peripheral port:

Internal DM settings

The Unit number for CV-series PLCs and CS1-series PL Cs should be configured as follows:

Rack-mounted Host Link unit:
Direct CPU RS232 port:
Direct CPU Peripheral port:
Remote SYSBUS/2 Peripheral port:

Note

Unit Setup dialog

Host Link settings dialog
Fixed as Unit 0
Fixed as Unit 0

The unit number rotary switches on the top of CV-series SIO units are the
unit number of that Special I/0O Unit on that PLC rack and not the Unit
number of the PLC on the serial network.

Network Communications (End Connection)

Each network supports a protocol (or set of rules) determining the manner in which a message is
transmitted. Requests sent by an are formatted into the relevant protocol with each message being
validated and prioritised according to the rules associated with that protocol.
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Once a connection has been established between a device and CX-Server, a set of routing rules and
tables are defined which organise the connection between these two processes. The manner of
routing depends upon the protocol (identified with each network type) involved in communicating
with the PLC.

The Routing Tables are created via offline table editors but they can also be manipulated online using
the CX-Net Network Configuration tool. These tables, athough they vary in format, contain the
network, memory and node address information required to ensure that information is directed
correctly across the relevant network. They also allow the connections to be defined for PLCs which
are to act as gateways. Refer to the PLC Tools User Manual Chapter 8 - CX-Net Network
Configuration Tool for further information.

When employing SYSMAC LINK, Controller Link and SYSMAC NET networks, each PLC must
be configured on each network to have different Node numbers. If two or more networks are joined
together, Routing Tables must be created and each network given a unique Network number in order
to establish communications between them.

FinsGateway is also needed to establish Controller Link, SYSMAC LINK and SYSMAC Net on NT;
refer to the FinsGateway Manual for further information.

When the Routing Tables have been set up, communications are possible from al the computers to
all PLCs. Although each network is given a specific number, the local network can aways be
addressed as network 0. If aseria connection has been made to a CV-series PLC, network O refersto
the network that is connected to the lowest humbered Special 1/0 Unit and the local PLC can be
addressed as Node 0.

Note Remember that the Unit number that is specified in the communications
dialog is not related to the Special 1/0 Unit number as set by the rotary
switches on the top of CV-series SIO units.

DeviceNet

The DeviceNet conforms to the DeviceNet open field network specification, which means that
devices (Master and Slave) produced by other manufacturers can be connected to the Network. A
wide range of field-level applications can thus be supported by combining valve devices, sensors, and
other devices.

Two types of communications are supported: 1. — Remote I/O master communications that
automatically transfer 1/0 between Slaves and the CPU Unit without any special programming in the
CPU Unit and 2. — Message communications that read/write messages, control operations, or
perform other functions for Master Units, CPU Units to which a Master Unit is mounted.

Differences between DeviceNet Network as FINS Network and other PLC Networks are as follows:
1. Maximum Node number and Maximum number of Nodes are 63.
2. No Datalink functionality.
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3. There are specific system setting areas and values for DeviceNet Network. Other application
software (DeviceNet Configurator) will support these settings so CX-Net 1.7/CX-P 3.0 does not
need to support the system setting.

The following diagram illustrates the connection options available to the C-series PLC.

Direct : Eni
Connection : Connection

CV-Series PLC

Cnly possible if the direct connection
is & C200HAENGE-ZNG-ZIR-1:

1. Controller Link

2. SYSMAC LINK

3. Ethernet

CS51-Series PLC

Only possible if the direct connection
iz & C200HRENE-ZIG-Z -

1. Corntraller Link (wired)

C-Series PLC

2. Ethernet
1. FTEMACIWAY CS1-Series PLC
3. SN SMAC WAY (Modem) :
4. Toolbus (Modem) Only possible it the direct connection
g. g?frgﬁiﬁg II__F-\II]E{ : : iz & C200HMEMGE-ZIG-Z-T:
7 Svehise NET 1. Contraller Link (optical)
3. Ethernet (Refer to Maote) .

C-Series PLC

Only possible if the direct connection
iz & C200H, C1000H, C2000H,
C200HAENSE-ZIG-FI4-T:

1. Controller Link

2. SYEMAC LIMK

3. Bthernet

4. STSMAC MET

Possible Network Combinations - C-series PLC

Note Only the following C-series PLCs can be used as a gateway:
C200H/HX/E/G/E-Z/G-2/X-Z, C1000H/HX/E/G/E-Z/G-Z/X-Z, C2000H.
The C200HS PLC cannot be used as a gateway connection. For Ethernet,
multiple destination access is possible.

Revision 1.7 Page 30



OMRON

CHAPTER 3 — Communications

The following diagram illustrates the connection options available to the CV-series PLC.

Direct
Connection

C-Series PLC

. ETSMAC AN

Toolbus

SYSMACYYAY (Modem)
. Toalbuz (Modem)
Controller Link

L SN SMAC LMK

S EMAC MET

. Bthernet (Refer to Mote)

M= Lo b —

End
Connection

CV-Series PLC

1. Controller Link
2. S SMAC LMK
3. Ethernet

4. STEMAC MNET

C51-Series PLC

1. Controller Link (wired)
2. Bthernet

C51-Series PLC

1. Cortraller Link (optical)

C-Series PLC

1. Controller Link
2.0 Sy SMAC LIMK
3. Ethernet

Possible Network Combinations - CV-series PLC

Note For Ethernet, multiple destination accessis possible.
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The following diagram illustrates the connection options available to the CS1-series PLC.

Direct
Connection

C-Series PLC

. ETSMAC WAY

. Toalbuzs (Refer to Mote)
S EMAC WA [Modem) :
. Toolbus (Modem) [ See Mate) -
. Coantroller Link (wired) :
S EMAC LMK (optical)
. Bthernet (Refer to Mote)

I s L=

End
Connection

CV-Series PLC

1. Corntroller Link Cwired)
2. Ethernest

CS51-Series PLC

1. SYSMAC LIMK
2. SYESMAC MET

CS51-5Series PLC

1. Cortraller Link (wired)
2. Contraller Link (optical)
3. Ethernet

C51-Series PLC

1. Controller Link {wired)
2. Bthernet

C-Series PLC

1. SYSMAC LINK

Possible Network Combinations — CS1-series PLC

Note For Toolbus (Modem) and Ethernet, multiple destination access is

possible.
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SYSMAC LINK

SYSMAC LINK is a high speed (2Mbits/sec) industrial network supporting the connection of
multiple C-series, CV-series, CS1 series and CJ1 series PLCs and one or more computers (so
enabling the interchange of information between these devices).

Communications are achieved by either Co-axial or Fibre Optic cabling and employing a SYSMAC
LINK Network Service Board (NSB), and Microsoft Windows device drivers.

Use the following procedure to configure SY SMAC LINK.

1,2,3... 1. EnsuretheNetwork TypeisSYSMAC LINK.
2. Click on the associated Settings pushbutton in the Change PLC dialog.

3. In the Network tab, define the FINS Destination Address by entering the
Network and Node.

4. Set the Response Timeout(s) to adjust for a slow network as necessary.

5. Enter the Frame Length in the Frame Length field. Refer to SYSMAC LINK
documentation for further information.

6. Inthe Driver field, select the appropriate options from the Shared RAM address
and Interrupt level fields. Refer to SYSVIAC LINK documentation for further
information.

7. Select the OK pushbutton to save the settings or select the Cancel pushbutton
to abort the operation.

SYSMAC NET
SYSMAC NET is a high speed (2Mbits/sec) LAN employed within mediunvlarge scale systems (C-
series PLCs and CV-series PLCs only).

Connections between the various PLCs and computers is achieved by fibre opticsin aring or loop
configuration allowing the exchange of data between the attached devices. The link is achieved by an
NSB and employment of Microsoft Windows device drivers. Refer to the SYSMAC NET Network
Support Board manual for details on installation.

Use the following procedure to configure SY SMAC NET.

1,2,3... 1. EnsuretheNetwork TypeisSYSMAC NET.
2. Click on the associated Settings pushbutton in the Change PLC dialog.

3. In the Network tab, define the FINS Destination Address by entering the
Network and Node.

4. Set the Response Timeout(s) to adjust for a slow network as necessary.

5. Enter the Frame Length in the Frame Length field. Refer to SYSMAC NET
documentation for further information.

6. Select the OK pushbutton to save the settings or select the Cancel pushbutton
to abort the operation.
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Controller Link

The Controller Link is an Factory Automation network that can send and receive large data packets
flexibly and easily among the PLCs and IBM PC/AT or compatible computers.

The Controller Link supports data links that enable data sharing and a message service that enables
sending and receiving data when required. Data link areas can be fregly set to create a flexible data
link system and effectively use data areas using the CX-Net Network Configuration tool. Refer theto
PLC Tools User Manual Chapter 8 - CX-Net Network Configuration Tool for further details.

The network is connected using shielded twisted-pair cable and high-volume data transmissions at
high speed enable construction of awide range of networks, from low level systemsto high. The link
between attached devices and the network is achieved by an OMRON Controller Link NSB (PCl and
ISA) and FinsGateway Version 3. Refer to the Controller Link operation manual for further details
on installation.

CS1-Series PL Cs support the wired Controller Link and the new optical Controller Link network.
Use the following procedure to configure Controller Link.

1,2,3... 1. Ensurethe Network Typeis Controller Link.
2. Click on the associated Settings pushbutton in the Change PLC dialog.

3. In the Network tab, define the FINS Destination Address by entering the
Network and Node.

4. Set the Response Timeout(s) to adjust for a slow network as necessary.

5. Enter the Frame Length in the Frame Length field. Refer to Controller Link
documentation for further information.

6. In the Driver tab, set the appropriate setting for the Shared RAM Address,
Interrupt Level and Baud Rate fields. Refer to Controller Link documentation
for further information.

7. Select an appropriate Node and Unit for the Network address.

8. Select the OK pushbutton to save the settings or select the Cancel pushbutton
to abort the operation.

Ethernet

Ethernet is a commonly used network capable of achieving a high rate of data transmission.

An NIC board must be installed inside the computer and TCP/IP protocols must be added and
configured.

Use the following procedure to configure Ethernet.
1,2,3... 1. Ensurethe Network Typeis Ethernet.

2. Click on the associated Settings pushbutton in the Change PLC dialog.

3. Inthe Network tab define the FINS Source Address: Network field by entering
the Network Address.
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4. Check the Network and Node addresses for the PLC and enter them in the FINS
Destination Address: Network field and Node field respectively.
5. Set the Response Timeout(s) to adjust for a slow network.
6. Enter the Frame Length in the Frame Length field.
7. In the Driver tab, check the Workstation Address and enter it in the
Workstation: Node Number field. Alternatively, select the Auto Detect setting
to automatically determine the workstation address.
8. Check the PLC IP address and enter it in the PLC: IP Addressfield.
9. Check the FINS UDP Port Number and enter it in the PLC: Port Number field.
10. Select the OK pushbutton to accept the settings. Select the Cancel pushbutton
to abort the operation.
Note: If using a subnet mask which is not 255.255.255.0 you will need to add the IP
Address of the PC wishing to connect, into the Ethernet unit. Do this using the 1/0
table.
PROM Writer

PROM Writer is a device alowing Programmable Read Only Memory (PROM) to be written to.

The following connection is required:

¢

RS232 connection via a standard serial port on the computer (COM1 etc.).

The Driver tab of the Network Settings dialog is similar to that belonging to SYSMAC WAY,
however, the transmission conditions should be set to:

¢ Baud Rate = 9600
¢ DataBits=8
¢ Parity = none
¢ StopBits=1
¢ or those of the particular PROM writer unit being used.
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CHAPTER 4
Import/Export Tool

This chapter describes the use of the CX-Server Import/Export tool, which alows FinsServer
database files and CVSS and LSS definitions of addresses and PLCs to be imported into CX-Server
project files. SYSWIN Text files can also be imported.

A CX-Server project file contains definitions of addresses and PLCs which may be accessed. The
concept of address and PLC definitions is not unique to CX-Server — the OMRON products CVSS
and LSS have similar concepts.

The Import/Export tool allows these definitions to be used by importing them into a CX-Server
project file.

Once these definitions of the PLCs and points (addresses) have been imported for use with CX-
Server, they may be used by a CX-Server client. For example, the addresses used in a CVSS
program could be used by the supervisory program SY SMAC-SCS.
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The status bar provides instant help.

The Import/Export tool main window provides all the menu options for importing CVSS, LSS, text
and FinsServer filesinto a CX-Server project file.

The main window shows the status of any import or export event which occurs. It shows any
decision which the Import/Export tool makes about importing into a CX-Server project.

=| The main window is continually updated with information as import and export
=
procedures are performed. This information can be cleared by selecting the Clear
Screen button from the toolbar.
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For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows
online help for further information.

E:,[; To access the Import/Export tool click the Start pushbutton on the Microsoft
—%  Windows
taskbar and select Programs/Omron/CX-Server/Import/Export from the menu.

r I To close the Import/Export tool, select the Close button in the title bar.

Supported Import/Export Data

Data which can be imported/exported varies according to the method used to createit.

CVSS creates information about PLCs and addresses. There are many types of file generated by
CVSS which have different filename suffixes and have different uses:

¢ PCN. Thisisadefinition of a PLC, containing a name, network number and node number.
¢ SBL. Thisisatable of nameswith addresses, similar to a CX-Server point definition.

¢ CMT. Thisisatable of address comments. The addresses listed usually match those used in the
SBL file.

¢ CUS This contains the definitions of custom prefixes for data-areas and ClIO groups which are
defined for the program.

LSS generates a single file (with the suffix .DAT) which contains details about many PLC programs.
The file'sinformation is organised into records about a single program. The only information stored
about the program which is useful in CX-Server is a table of address comments. Both LSS v3 and
LSS v6 files can be imported.

Text files are similar to Microsoft Windows ‘.INI’ filesin structure. Headers within this file identify
a chapter of addresses and a chapter of PLC information. Addresses can be imported from the text
file for a CX-Server project PLC. Address definitions (points) inside a chosen CX-Server project
PLC that are contained in a single CX-Server project point group can be exported.

FinsServer files are tagged database files (with the suffix *.MDB’) containing node, PLC and network
details.

Note FinsServer tagged database utilities must be installed on the PC to
import/export *.MDB’ files.

CX-Server Project Selection

In order to import information you must first open an existing CX-Server project file. The Project
menu contains options for selection and editing of a CX-Server project. The importing operations
then affect this CX-Server project. Only one CX-Server project is selected at any one time.

Use the following procedure to create a new CX-Server project.
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1,23.. Select the New button in the toolbar. The Create Project dialog is displayed.

1
[ 2. TheCX-Server project must be saved before it can be edited. Enter afile name
in the File name field. An existing CX-Server project can be overwritten by
selecting a.CDM file displayed in the Create project dialog.

3. Select the Save pushbutton to save the new project or the Cancel pushbutton to
abort the operation. CX-Server files have a.CDM extension.

Use the following procedure to open an existing CX-Server project.

1,2,3... 1. Selectthe Open button from the toolbar to open a CX-Server project file.

El 2. A standard File Open dialog is displayed. Select a file from the Open dialog,
followed by the Open pushbutton. PLC Memory files have a.CDM extension.

El 3. Select the Edit option from the Project menu to edit a CX-Server project.
Refer to Chapter 2 - Introduction to CX-Server Projects for further details.

4. Select Close from the Project menu to close the currently open CX-Server
project.
The content of the Import/Export tool can be printed. Use the following procedure to print details.

1,2,3... 1. SelectthePrint button fromthetoolbar. A standard Print dialog is displayed.

2. Set uptherequired printer settings. Select the OK pushbutton to print the PLC
=i
Memory details or the Cancel pushbutton to abort the operation.

Import
The following paragraphs describe the methods available for importing data into a CX-Server project.

Importing from CVSS
Use the following procedure to import from CV SS.

1,23.. 1.  Select the Import CVSS button from the toolbar. A standard File Open dialog
is shown; select a CVSS file to import and select the Open pushbutton or
select the Cancel pushbutton to abort the operation. Specific CV SSfile types
can be selected from the Files of Type field: either CVSSPLCs, CVSS Memory,
CVSS 10 Names or CVSS 10 Comments. Once the Open pushbutton has been
selected,. The CVSS Import Options dialog is displayed.

GH| 2. Toimport points, (i.e. any addresses and address comments contained in the
selected files) select a destination PLC from the Destination PLC field for the
new addresses to use. The device type and CPU of the currently selected PLC
is shown below the Destination PLC field. Alternatively, select a PLC from
the Default Type field. Once imported, a message is displayed indicating that
conversion is complete.

Note The Imported Points option or the Imported PLCs option is only available
if the relevant type of object isfound in the files chosen.
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PLC details can be edited via the Edit pushbutton. The procedure for doing this is described in
Chapter 2 - Introduction to CX-Server Projects.

Importing from LSS
Use the following procedure to import from L SS.
1,2,3... 1. Selectthelmport LSS button from the toolbar. A standard File Open dialog is
shown: select a LSS file to import and select the Open pushbutton or select the

Cancel pushbutton to abort the operation. The LSS Import Options dialog is
displayed, listing the programs detailed in the file.

L1 2. Select aprogram from the Imported Programfield.

£
P

3. Select the destination PLC from the Destination PLC field to which any
addresses and comments found in the chosen program are to be added. The
type of PLC that has been selected (device and CPU number) is shown below
the drop-down list box.

4.  Onceimported, a message is displayed indicating that conversion is complete.

PLC details can be edited via the Edit pushbutton. The procedure for doing this is described in
Chapter 2 - Introduction to CX-Server Projects.

Importing from Text Files
Use the following procedure to import from Text.

1,2,3... 1. Selectthelmport LSS button from the toolbar. A standard File Open dialog is
shown: select a text file to import and click on OK or select the Cancel
pushbutton to abort the operation. The Import Text File dialog is displayed.

n 2. Select a PLC for which the address definitions in the file can be linked. The
PLC typethat is givenin thefile is shown.

3. Select a matching device type from the list of PLCs which are contained in the
current CX-Server project. This ensures that any imported addresses are valid
on the chosen PLC. Once afile has been selected, the Import Text Filedialog is
displayed. Once imported, a message is displayed indicating that conversion is
complete.

PLC details can be edited via the Edit pushbutton. A PLC can be added if none are suitable for the
import operation. Refer to Chapter 2 - Introduction to CX-Server Projects for further information.

Importing from FinsServer
Use the following procedure to import from FinsServer.
1,2,3... 1. SelecttheImport from TagDB button from the toolbar. Provided FinsServer

tagged database utilities has been correctly installed, the FinsServer Import
Option dialog is displayed.
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@2.

Select the TagDB PLC name in the Node in TagDB field. Details of tags,
device type and network nodes are displayed below the list box.

e + Theplusicon indicates that tagged data is assigned to the PLC listed in
the Node in TagDB field.

 — The minus icon indicates that there is no tagged data assigned to the
PLC listed in the Node in TagDB field. It is not possible to import a node
which has no tag data.

If required, enter a CX-Server project group name in the Group Name field
ensuring that the name does not exceed 64 characters. By default, the field is set
to ‘FinsServer’.

Enter a PLC comment to be written to each imported tag data in the Comment
field. By default, the field is set to ‘Imported by FinsServer’.

Set the Import to same name PLC field to ON to use the PLC in the current CX-
Server project. Deselect the Import to same name PLC field to select a specific
PLC from the PLC in Project field. If necessary, PLC details can be edited via
the Edit Project pushbutton. Refer to Chapter 2 - Introduction to CX-Server
Projects for further information.

Select the Import Tag pushbutton, an ‘Imported’ message is displayed once the
operation has concluded.

Select the Close pushbutton. The success or failure of the import operation is
displayed in the Import/Export tool status dialog. Select the OK pushbutton to
proceed.

The Import Tag pushbutton is disabled if the destination and source PLC
types are different. If there are other differences (apart from PLC type),
the import can proceed but no Export Log is generated.

The maximum size of a TagDB is as follows:;

14
¢
14

¢
14

Export

Network: 20;

Node: 100;

Tag: 200 per Node.
The maximum size of a CX-Server project is as follows;

PLC: 100;

Points: 200 per PLC.

PLC data can be exported to either text or FinsServer files, for example symbol definitions can be
exported as a FinsServer (*.MDB’) file which can be read by Microsoft Excel (text files can aso be
imported into Microsoft Excel).
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Exporting Data to Text Files

Use the following procedure to export al of the points from a particular point group, which are linked
to aparticular PLC (i.e. the point addresses refer to the PLC) to text file.

1,2,3... 1. Selectthe Export Text button from the toolbar. The Export Text File dialog is
displayed.
2. Select aPLC from the Source PLC field.

3. Itispossibleto extract only partial data by inserting a path for a particular point
by entering a pathname in Source Point Group field.

4. Select the OK pushbutton to accept the settings. Select the Cancel pushbutton
to abort the operation. Select the Edit Project button to edit the CX-Server
project's PLC. Point definitions can also be added to the CX-Server project if
desired, before export from this function. Refer to Chapter 2 - Introduction to
CX-Server Projects for further information. Once the OK pushbutton has been
selected, the Export Data File dialog is displayed. Thisis a standard Microsoft
Windows File Open dialog.

5. Insert afilename to export in the File name field and click on OK or select the
Cancel pushbutton to abort the operation.

6. A message is displayed in the Import/Export tool that the export is beginning.
Another message is shown indicating the success of the export. The device
details of the chosen PLC are copied to the selected file if the export is
successful.

5%

Exporting Data to FinsServer Files
Use the following procedure to export data to FinsServer files.

1,2,3... 1. Select the Export to TagDB button from the toolbar. The FinsServer Export
Option dialog is displayed.
B« 2. Selectthe PLC from the PLC in Project field. Details of tags, device type and
network nodes are displayed below the list box.

e + The plusicon indicates that tagged data is assigned to the PLC listed in
the Node in TagDB field.

* - Theminusicon indicates that there is no tagged data assigned to the PLC
listed in the Node in TagDB field.

3. Set the Export to same name PLC field to use the PLC in the current CX-
Server project. Deselect the Export to same name PLC field to select a specific
PLC from the PLC in Project field. If necessary, tag details can be edited via
the Edit TagDB pushbutton. Details of device type and network nodes are
displayed below the drop-down list.
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Select the Export Point pushbutton. The Export Point pushbutton is disabled
if the destination and source PLC types are different. If there are other

differences (apart from PLC type) the export can proceed but no Export Log is
generated.

Select the Close pushbutton. The success or failure of the import operation is

displayed in the Import/Export tool status dialog. Select the OK pushbutton to
proceed.
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CHAPTER 5
DDE Manager Tool

This chapter introduces the CX-Server DDE Manager tool and describes its use in providing the
interface to other Microsoft Windows-based applications.

The DDE Manager tool permits CX-Server to communicate with other Microsoft Windows programs
via the Microsoft Windows Dynamic Data Exchange Management Library (DDEML) facility. The
links established by the DDE Manager tool alows a Microsoft Windows application, such as
Microsoft Excel or Lotus 123, to transmit instructions to CX-Server in order to update points or to
obtain information about a PLC address. This functionality is achieved without the necessity of
additional programming (although macro programming may be required in order to update
information in a PL C address, depending on the used).

The creation of such a link establishes a client/server relationship between the application and the
CX-Server project, where the application is (usually) the client and CX-Server isthe server.

OOE link reference to point
in Ca-Server project

fr EXCEL SPREADSHEET
CX-Server
——— PROJECT
- || Poird1
Foint :
Information Pn:rﬂ
Paintn

Spreadshest Cell

The dialogs available via the DDE Manager tool are the same as those illustrated in Chapter 2 -
Introduction to CX-Server Projects; this chapter should be referred to for further information.

The Restore option and Maximise option from the DDE Manager menu are not used.
232 The DDE Manager tool is accessed from the Start pushbutton on the Microsoft
— Windows taskbar and appears as only a pushbutton in the taskbar.

To close the DDE Manager tool, select the DDE Manager tool in the taskbar with the right-mouse
button and click on Close.

Establishing DDE Links

For an application to obtain information from a PLC, a CX-Server project must first be set up via the
DDE Manager tool. The project file should contain details of the PLC and the points which are to be
referenced (an existing CX-Server project can also be used); the application references the CX-Server
project via the point names within the project.
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When this information has been configured, the application which is requesting the point data must
be opened in order to link it with CX-Server. The link can either be manually entered in the
application or the reference can be copied from the CX-Server project. The manner in which such
links are established within a Microsoft Windows application (supported by the DDE facility) varies
according to the application used and so the appropriate reference manual must be consulted.

Defining a Link
The information contained within the link reference required by the DDE Manager tool must include
service, topic and item identifiers.

Service

The service name indicating where the data is held is identified by the application specifier. Within
CX-Server thisisaways ‘CDMDDE'.

Topic

The CX-Server project name and the path by which it is accessed in CX-Server is identified by the
topic specifier. The CX-Server project name is identified by the ‘.cdm’ extension; for example,
“C:\CX-Server\factory.cdm” identifies the CX-Server project ‘factory’ in the “C:\CX-Server”
directory.

Iltem

The point to be referenced by the CX-Server project isidentified by the item specifier, (this must also
include the group path); for example “\pumpl”.

The complete reference for this point (defined by ‘factory.cdm’) would include the following
information:

¢ Service="“CDMDDE"
¢ Topic ="“C:\CX-Server\factory.cdm’
¢ ltem="\pumpl”

Its interpretation into a link reference and the format this takes depends upon the application
requesting the information (in which case it is necessary to refer to the appropriate application user
manual); for example in Microsoft Excel the link would be entered in a cell as:

“=CDVDDE! ' C:\ CX- Server\factory.cdm !’ \ punpl’ ”.
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Copying a Point

The address information for a point is held in the CX-Server project file
indicated by the topic identifier.

Although it is possible to enter details of alink in aclient manually, it may be quicker to use the DDE
Manager tool facility to format the link details automatically.

The Project Editor (DDE Manager) allows a point to be linked to an application so that the contents
of the point can be displayed within that application; it is obtained via the Copy Selection option on

the DDE Manager menu.
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Use the following procedure to copy a point:

1,2,3... 1. Intoanother application, i.e. Microsoft Excel.
(8 Openthe DDE Manager and navigate to the appropriate location.

(b) Select the point from the list displayed. If necessary select the required
group from the Group hierarchy.

() Select the Edit/Copy option or click the copy button to copy the selected
point to the Microsoft Windows Clipboard.

(d) Open the required application and position the cursor at the point in the
application where this information is to be pasted; for example a
Microsoft Excel cell.

(e) Select the Paste option in the application to insert the copy. The exact
nature of the Paste option varies according to the application and may
takes the form of a Paste Special option.

2. Into another Device or Group:
(@ Openthe DDE Manager and navigate to the appropriate location.

(b) Select the point from the Tree view. If necessary select the required
group from the Group hierarchy.

(c) Select the Edit/Copy option or click the Copy Selection button in the
toolbar.

(d) Navigate to the point where the information is to be pasted and select
Edit/Paste or click the Paste Selection button.

Note that attempting to paste a copied point into the same location will
warn you that a point of the same description already exists.

Details about a point can be displayed by right clicking on the point and selecting the Properties
option from the menu.

Automatic versus Manual Updates

The links created between an application and the CX-Server project can be defined as ‘active’, in
which case the entry in the application file referencing that point is updated automatically with point
data, or the link can be ‘manual’, i.e. the user controls when and if point data in an application is
updated.

Automatic Updates

The application requesting data relating to a specific point is updated by the DDE Manager tool
whenever the point data changes; this occurs at defined time intervals when the DDE Manager tool
examines the PLC address associated with the point to see whether the information it contains has
changed or not. The update rate can be specified when the CX-Server project is created, alternatively
the DDE Manager tool uses a default update rate if one has not been set.
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Update rates can be included when defining the item specifier chapter of the DDE link; for example,
atimeinterval of 5 seconds for the item specified by “\pumpl” is expressed as “\pumpl1,5”. The full
DDE link becomes. “=CDMDDEL"'C:\CX-Server\factory.cdm’!"\pumpl,5'”

An update rate indicated in this manner overrides the default rate.

Manual Updates

If a manua link has been specified between an application and the CX-Server project, the
information contained within the application is not updated until the appropriate action is taken by the
user.

Within Microsoft Excel, this would be achieved by highlighting the cell containing the link and
selecting Calculate Now from the Options menu to update the displayed contents of the cell.

Defining Update Intervals

The Update Interval dialog allows a default update rate (in seconds) to be assigned to new data
requests. Use the following procedure to define an update interval:
1,2,3... 1. Selectthe Update Interval option from the DDE Manager menu.

2. Enter the required update rate (in seconds) in the Interval field; this has a
maximum value of 65535.

3.  Select the OK pushbutton to save the setting and close the dialog.

The new rate applies to those points which are activated after this rate has been set. Currently active
points are not affected.

Note The default time interval for the DDE Manager tool (when it is initially
installed) is set to 15 seconds.

Special Data Types

The LREAL data type is now supported by the Points Editor for the CS1H-H and CJ1H-H PLCs.
Support for the LREAL type is as the IEEE754 Double precision (1.7E +308/-307) as defined by
Microsoft®.
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CHAPTER 6

Performance Monitor Tool

The Performance Monitor tool provides a facility to monitor system performance of active

connections and can also display the limits of performance against user instructions.

Particularly, it allows monitoring of communications. For example, a SYSMAC WAY connection
configured at 9,600 baud, 7 data bits, even parity and 2 stop bits, transmits 10 bits per byte at 9,600
bits per second; this means that the absolute maximum throughput of the cable is 960 bytes per
second. Requesting or transmitting data at this rate results in slow response times. The Performance

Monitor tool has been engineered to show this throughput figure for PLC connections.

The Performance Monitor tool can be set so that it is not obscured by other windows by selecting
Always on top from the Options menu.

.,‘l'L_

To access the Performance Monitor tool select the CX-Server Performance Monitor
tool from the Start pushbutton on the Microsoft Windows taskbar.

r I To close the Performance Monitor tool, select the Close button in the title bar.
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The Performance tab displays an automated performance history and performance load for the
selected active connection in the Component option or for the overall performance. Details of
activity are described in terms of the number of open PLCs, active messages and open points in the
Totalsfield.

The Satistics tab displays the number of bytes being transmitted and received by the selected active
connection. The limit to the number of characters that can be processed per second is described by
the Theoretical CPSfield. The number of characters currently active is described by the Active CPS
field. The PLC Average Latency (ms) option shows how long it is taking the PLC to process the
information in milliseconds.

Watching the Performance Monitor tool fluctuate between for example, 0% and 135%, indicates that
it is actually not possible to retrieve al the data requested in the time required according to the
connected baud rate.

If the actual characters per second is greater than the theoretical maximum characters per second then
performance decreases. The performance load will fluctuate and the PLC average latency will
increase. At this point attention is required to the user instructions that are responsible for slowing
performance.

m The taskbar setting provides an at-a-glance indication of performance. The more the

: icon is filled green, the greater the performance load. If the icon begins to fill red,
then the actua characters per second is greater than the theoretical maximum
characters per second load.

To refresh the Performance Monitor tool details, select the Refresh Now option from the View menu.

The performance Monitor tool can be hidden from the desktop by minimising the window, and can be
hidden from the taskbar in its minimised state by selecting Hide on Minimise option from the Options
menu. Once hidden, the Performance Monitor tool can be restored by clicking the taskbar pushbutton
or click the right-mouse button and from the menu select restore.
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APPENDIX A
Network Availability

The following tables indicate the network available to each PLC device group. FinsGateway has no
network availability and is not described

Note Modem connection is also available by Toolbus or SYSMAC WAY if a
Modem device has been configured in Microsoft Windows. Any device
supporting Toolbus or SYSMAC WAY also supports Modem connections.
Refer to standard Microsoft Windows documentation for details on

configuring a Modem device.

Note Where DeviceNet is indicated as an available network type for a given
PLC, direct connection from a PC is not possible (No NSB support).

Instead, connect viaa Seria Port (COM1 etc.), or an another network type.

C**H Device Group

Device SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
Type WAY NET LINK Link Net
C20H Yes - - -
C28H Yes - - -
C40H Yes - - -
C60H Yes - - -
C**K Device Group
Device SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
Type WAY NET LINK Link Net
C20K Yes - - -
C28K Yes - - -
C40K Yes - - -
C60K Yes - - -
C**P Device Group
Device SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
Type WAY NET LINK Link Net
C20P Yes - - -
C28P Yes - - -
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Device SYSMAC Toolbus SYSMAC SYSMAC Controller Ethernet Device
Type WAY NET LINK Link Net
C40P Yes - - - - - -
C60P Yes - - - - - -
C1000H Device Group
Device SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
Type WAY NET LINK Link Net
CPUO1 Yes - Yes Yes - - -
C20 Device Group
Device SYSMAC Toolbus SYSMAC SYSMAC Controller Ethernet Device
Type WAY NET LINK Link Net
C20 Yes - - - - - -
C20 ves | - | - - -
C2000H Device Group
Device SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
Type WAY NET LINK Link Net
CPUO1 Yes - Yes Yes - - -
C2000 Yes - Yes - - - -
C200H Device Group
Device SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
Type WAY NET LINK Link Net
CPUO1 Yes - - - - - -
CPUO02 Yes - - - - - -
CPUO3 Yes - - - - - -
CPU21 Yes - - - - - -
CPU21 Yes - - - - - -
CPU22 Yes - - - - - -
CPU23 Yes - - - - - -
CPU11 Yes - Yes Yes - - -
CPU31 Yes - Yes Yes - - -

Revision 1.7

Page 54




APPENDIX A — Network Availability

C200HE Device Group

Device Type SYSMAC Toolbus SYSMAC SYSMAC Controller Ethernet Device
WAY NET LINK Link Net
CPU11 - Yes - - - - -
CPU32 - Yes Yes Yes Yes Yes -
CPU42 Yes Yes Yes Yes Yes Yes -
C200HE-Z Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
CPU11 Yes Yes - - - - -
CPU32 Yes Yes Yes Yes Yes Yes -
CPUA42 Yes Yes Yes Yes Yes Yes -
C200HG Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPU33 Yes Yes Yes Yes Yes Yes -
CPU43 Yes Yes Yes Yes Yes Yes -
CPUS3 Yes Yes Yes Yes Yes Yes -
CPUGB3 Yes Yes Yes Yes Yes Yes -
C200HG-Z Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPU33 Yes Yes Yes Yes Yes Yes -
CPU43 Yes Yes Yes Yes Yes Yes -
CPUS53 Yes Yes Yes Yes Yes Yes -
CPUGB3 Yes Yes Yes Yes Yes Yes -
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C200HS Device Group

Device Type SYSMAC Toolbus SYSMAC SYSMAC Controller Ethernet Device
WAY NET LINK Link Net
CPUO1 Yes Yes - - - - -
CPUO3 Yes Yes - - - - -
CPU11 Yes Yes Yes Yes - - -
CPU13 Yes Yes Yes Yes - - -
C200HX Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPU34 - Yes Yes Yes Yes Yes -
CPU44 Yes Yes Yes Yes Yes Yes -
CPU54 - Yes Yes Yes Yes Yes -
CPU6G4 Yes Yes Yes Yes Yes Yes -
C200HX-Z Device Group
Device Type SYSMAC Toolbus SYSMAC SYSMAC Controller Ethernet Device
WAY NET LINK Link Net
CPU34 Yes Yes Yes Yes Yes Yes -
CPU44 Yes Yes Yes Yes Yes Yes -
CPU5S4 Yes Yes Yes Yes Yes Yes -
CPU64 Yes Yes Yes Yes Yes Yes -
C500 Device Group
Device Type SYSMAC Toolbus SYSMAC SYSMAC Controller Ethernet Device
WAY NET LINK Link Net
C500 Yes - Yes - - - -
C250 Yes - - - - - -
C120 Yes - - - - - -
C50 Yes - - - - - -
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CJ1G Device Group

Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
CPU45 Yes Yes - - Yes Yes Yes
CPU44 Yes Yes - - Yes Yes Yes
CJ1G-H Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
CPU45 Yes Yes - - Yes Yes Yes
CPU44 Yes Yes - - Yes Yes Yes
CPU43 Yes Yes - - Yes Yes Yes
CPUA42 Yes Yes - - Yes Yes Yes
CJ1H-H Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPU66 Yes Yes - Yes Yes Yes Yes
CPUG5 Yes Yes - Yes Yes Yes Yes
CJ1M Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPU12 Yes Yes - - Yes Yes Yes
CPU13 Yes Yes - - Yes Yes Yes
CPU22 Yes Yes - - Yes Yes Yes
CPU23 Yes Yes - - Yes Yes Yes
CPM1 (CPM1A/CPM2*) Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
CPU10 Yes Yes - - - - -
CPU20 Yes Yes - - - - -
CPU30 Yes Yes - - - - -
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CPM2*-S* Device Group

Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
N/A Yes Yes - - - - Yes

CQM1 Device Group

Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net

CpPU11 Yes Yes - - - - -
CPU21 Yes Yes - - - - -
CPU41 Yes Yes - - - - -
CPU42 Yes Yes - - - - -
CPU43 Yes Yes - - - -

CPU44 Yes Yes - - - -

CQM1H Device Group

Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
CpPU11 Yes Yes - - - - -
CpPU21 Yes Yes - - - - -
CPU51 Yes Yes - - Yes - -
CPU61 Yes Yes - - Yes - -

CS1G/CS1G-H Device Group

Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
CPU45 Yes Yes - Yes Yes Yes Yes
CPU44 Yes Yes - Yes Yes Yes Yes
CPU43 Yes Yes - Yes Yes Yes Yes
CPU42 Yes Yes - Yes Yes Yes Yes
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CS1H/CS1H-H Device Group

Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPU6G7 Yes Yes - Yes Yes Yes Yes
CPUG6 Yes Yes - Yes Yes Yes Yes
CPUG5 Yes Yes - Yes Yes Yes Yes
CPU6G4 Yes Yes - Yes Yes Yes Yes
CPUG3 Yes Yes - Yes Yes Yes Yes
IDSC Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
Cco1 Yes Yes - - - - -
Cco2 Yes Yes - - - - -
SRM1 - SRM1 V2 Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
co1 Yes Yes - - - - -
Cco2 Yes Yes - - - - -
CV1000 Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPUO1 Yes Yes Yes Yes Yes Yes -
CV2000 Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
CPUO1 Yes Yes Yes Yes Yes Yes -
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CV500 Device Group

Revision 1.7

Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPUO1 Yes Yes Yes Yes Yes Yes -
CVML1 Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller | Ethernet Device
WAY NET LINK Link Net
CPUO1 Yes Yes Yes Yes Yes Yes -
CPU11 Yes Yes Yes Yes Yes Yes -
CVM1-V2 Device Group
Device Type | SYSMAC Toolbus SYSMAC SYSMAC | Controller Ethernet Device
WAY NET LINK Link Net
CPUO1 Yes Yes Yes Yes Yes Yes -
CPU11 Yes Yes Yes Yes Yes Yes -
CPU21 Yes Yes Yes Yes Yes Yes -
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APPENDIX B
PLC Memory Areas

The following tables provide memory area details for each device group.

Some tables indicate special addresses. These can be as follows:

¢ CLOCK. Thisalows reading/writing of a PLC's real-time clock.

¢ BANKNO. Thisallows reading/writing of a PLC's extended memory bank number.

¢ MODE. Thisallowsreading/writing of a PLC's run-mode.

C**H Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
TC 0 511 Present Value Status Yes FC
DM 0 1999 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 252 Yes Yes Yes FC
IR (opt) 253 255 (bit 7) Yes Yes No
LR 0 63 Yes Yes Yes FC
SR (opt) 247 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
Specia addresses CLOCK, MODE.
C**K Device Group
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
TC 0 47 Present Value Status Yes FC
DM 0 63 Yes No Yes
HR 0 9 Yes Yes Yes FC
IR (opt) 0 18 (bit 7) Yes Yes Yes FC
SR (opt) 18 (bit 8) 19 (bit 7) No Yes No
TR 0 0 (bit 7) No Yes No
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C**P Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
TC 0 47 Present Value Status Yes FC
DM 0 63 Yes No Yes
HR 0 9 Yes Yes Yes FC
IR (opt) 0 18 (bit 7) Yes Yes Yes FC
SR (opt) 18 (bit 8) 19 (bit 7) No Yes No
TR 0 0 (bit 7) No Yes No
C1000H Device Group
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
TC 0 511 Present Value Status Yes FC
DM 0 4095 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 236 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 237 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
Specia addresses. MODE.
C20 Device Group
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
TC 0 47 Present Value Status Yes FC
HR 0 9 Yes Yes Yes FC
IR (opt) 0 18 (bit 7) Yes Yes Yes FC
SR (opt) 18 (bit 8) 19 (bit 7) No Yes No
TR 0 0 (bit 7) No Yes No
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C2000H Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
TC 0 511 Present Value Status Yes FC
DM 0 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 236 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 237 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
Specia addresses. MODE.
C200H Device Group
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 1999 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 235 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 236 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
TC 0 511 Present Value Status Yes FC

Specia addresses. CLOCK, MODE.

Revision 1.7

Page 63




OMRON

APPENDIX B — PLC Memory Areas

C200HE Device Group

General Memory Areas

Memory Areas for any CPU.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 4095 Yes No Yes
DM 6000 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 235 Yes Yes Yes FC
IR (opt) 300 511 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 236 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
SR (opt) 256 299 Yes Yes Yes FC
TR 0 0 (bit 7) No Yes No
SR (opt) 256 299 Yes Yes Yes FC
TC 0 511 Present Value Status Yes FC
CPU 32/42 Memory Areas
Memory Areasin addition to general memory areas.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
DM 4096 5999 Yes No Yes

Specia addresses. CLOCK, MODE.
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C200HE-Z Device Group

General Memory Areas

Memory Areas for any CPU.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 4095 Yes No Yes
DM 6000 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 235 Yes Yes Yes FC
IR (opt) 300 511 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 236 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
SR (opt) 256 299 Yes Yes Yes FC
TR 0 0 (bit 7) No Yes No
SR (opt) 256 299 Yes Yes Yes FC
TC 0 511 Present Value Status Yes FC

CPU 32/42 Device Group
Memory Areasin addition to general memory areas.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
DM 4096 5999 Yes No Yes

Specia addresses. CLOCK, MODE.
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C200HG Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 235 Yes Yes Yes FC
IR (opt) 300 511 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 236 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
SR (opt) 256 299 Yes Yes Yes FC
TR 0 0 (bit 7) No Yes No
TC 0 511 Present Value Status Yes FC
EM 0 6143 *1 Yes No Yes -n

Specia addresses. CLOCK, MODE, BANKNO.

C200HG-Z Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 235 Yes Yes Yes FC
IR (opt) 300 511 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 236 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
SR (opt) 256 299 Yes Yes Yes FC
TR 0 0 (bit 7) No Yes No
TC 0 511 Present Value Status Yes FC
EM 0 6143*1 Yes No Yes -n

Specia addresses. CLOCK, MODE, BANKNO.
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C200HS Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 235 Yes Yes Yes FC
IR (opt) 300 511 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 236 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
SR (opt) 256 299 Yes Yes Yes FC
TC 0 511 Present Value Status Yes FC
TR 0 0 (bit 7) No Yes No

Specia addresses. CLOCK, MODE.

C200HX Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 235 Yes Yes Yes FC
IR (opt) 300 511 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 236 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
SR (opt) 256 299 Yes Yes Yes FC
TR 0 0 (bit 7) No Yes No
TC 0 511 Present Value Status Yes FC
EM 0 6143 *3 Yes No Yes -n

Specia addresses. CLOCK, MODE, BANKNO.
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C200HX-Z Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 235 Yes Yes Yes FC
IR (opt) 300 511 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 236 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
SR (opt) 256 299 Yes Yes Yes FC
TR 0 (bit 7) No Yes No
TC 511 Present Value Status Yes FC
EM 6143 *3 Yes No Yes -n
CPU 65 Memory Areas
Memory Areasin addition to general memory areas.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
EM 0 6143 *8 Yes No Yes -n
CPU 85 Memory Areas
Memory Areas in addition to general memory areas.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
EM 0 6143 * 16 Yes No Yes -n

Specia addresses. CLOCK, MODE, BANKNO.
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C500 Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
TC 0 127 Present Value Status Yes FC
DM 0 511 Yes No Yes
HR 0 31 Yes Yes Yes FC
IR (opt) 0 57 Yes Yes Yes FC
LR 0 31 Yes Yes Yes FC
SR (opt) 58 60 Yes Yes Yes FC
SR (opt) 61 63 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
CJ1G Device Group
General Memory Areas
General Memory Areas for all CPUs 44 and 45.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
IR 0 15 Yes (double) No Yes
DR 0 15 Yes No Yes fc
TK 0 31 Status Yes No
A 0 447 Yes Yes No
A 448 959 Yes Yes Yes fc
H 0 511 Yes Yes Yes
w 0 511 Yes Yes Yes
CIO(opt) 0 6143 Yes Yes Yes fc
T 0 4095 Present Value Status Yes FC
C 0 4095 Present Value Status Yes FC
D 0 32767 Yes No Yes
CF 0 11 No Yes No
CF 100 104 No Yes No
CF 113 114 No Yes No
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CPU 44 Memory Areas
Memory Areasin addition to General Memory Aress.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 *1 Yes No Yes -n
CPU 45 Memory Areas
Memory Areas in addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 * 3 Yes No Yes -n
Special addresses: (all CPUs): CLOCK, MODE.
(CPU 44/45): BANKNO.
CJ1G-H Device Group
General Memory Areas
General Memory Areasfor all CPUs 42, 43, 44 and 45.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
IR 0 15 Yes (double) No Yes
DR 0 15 Yes No Yes fc
TK 0 31 Status Yes No
A 0 447 Yes Yes No
A 448 959 Yes Yes Yes fc
H 0 511 Yes Yes Yes
W 0 511 Yes Yes Yes
CIO(opt) 0 6143 Yes Yes Yes fc
T 0 4095 Present Value Status Yes FC
C 0 4095 Present Value Status Yes FC
D 0 32767 Yes No Yes
CF 0 11 No Yes No
CF 100 104 No Yes No
CF 113 114 No Yes No
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CPU 42 Memory Areas

Memory Areasin addition to General Memory Aress.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 * 1 Yes No Yes -n
CPU 43 Memory Areas
Memory Areasin addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 * 1 Yes No Yes -n
CPU 44 Memory Areas
Memory Areas in addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 * 1 Yes No Yes -n
CPU 45 Memory Areas
Memory Areasin addition to General Memory Aresas.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 * 3 Yes No Yes -n
Special addresses: (all CPUs): CLOCK, MODE.
(CPU 44/45): BANKNO.
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CJ1H-H Device Group

General Memory Areas
General Memory Areas for all CPUs 65 and 66

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
CIO(opt) 0 6143 Yes Yes Yes fc
DR 0 15 Yes No Yes fc
TK 0 31 Status Yes No
A 0 447 Yes Yes No
A 448 959 Yes Yes Yes fc
H 0 511 Yes Yes Yes fc
W 0 511 Yes Yes Yes
T 0 4095 Present Value Status Yes FC
C 0 4095 Present Value Status Yes FC
D 0 32767 Yes No Yes
IR 0 15 Yes (double) No Yes
CF 0 11 No Yes No
CF 100 104 No Yes No
CF 113 114 No Yes No
CPU 65 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*3 Yes No Yes -n
CPU 66 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*7 Yes No Yes -n
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CJ1M Device Group

General Memory Areas
General Memory Areasfor all CPUs 12, 13, 22 and 23.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
IR 0 15 Yes (double) No Yes
DR 0 15 Yes No Yes fc
TK 0 31 Status Yes No
A 0 447 Yes Yes No
A 448 959 Yes Yes Yes fc
H 0 511 Yes Yes Yes
W 0 511 Yes Yes Yes
CIO(opt) 0 6143 Yes Yes Yes fc
T 0 4095 Present Value Status Yes FC
C 0 4095 Present Value Status Yes FC
D 0 32767 Yes No Yes
CF 0 11 No Yes No
CF 100 104 No Yes No
CF 113 114 No Yes No

CPM1 (CPM1A) Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 15 Yes Yes Yes FC
DM 0 1023 Yes No Yes
DM 6144 6655 Yes No Yes
HR 0 19 Yes Yes Yes FC
IR (opt) 0 19 Yes Yes Yes FC
IR (opt) 200 231 Yes Yes Yes FC
LR 0 15 Yes Yes Yes FC
SR (opt) 232 252 Yes Yes Yes FC
TR 0 0 (bit 7) No Yes No
TC 0 127 Present Value Status Yes FC

Specia addresses. MODE.
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CPM2*/CPM2*-S* Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 23 Yes Yes Yes FC
DM 0 2047 Yes No Yes
DM 6144 6599 Yes No Yes
DM 6600 6655 Yes No No
HR 0 19 Yes Yes Yes FC
IR (opt) 0 49 Yes Yes Yes FC
IR (opt) 200 227 Yes Yes Yes FC
LR 0 15 Yes Yes Yes FC
SR (opt) 228 252 Yes Yes Yes FC
SR(opt) 253 255 Yes Yes No
TR 0 0 (bit 7) No Yes No
TC 0 127 Present Value Status Yes FC
Specia addresses. MODE.
CQM1 Device Group
Memory Areas
Memory Areas for all CPUs.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 1023 Yes No Yes
DM 6144 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 243 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 244 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
TC 0 511 Present Value Status Yes FC
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CPU 41/42/43/44/45 Memory Areas
Memory Areasin addition to general memory areas.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
DM 1024 6143 Yes No Yes
Specia addresses. CLOCK, MODE.
CQM1H Device Group
Memory Areas
Memory Areas for all CPUs.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
HR 0 99 Yes Yes Yes FC
IR (opt) 0 243 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 244 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
TC 0 511 Present Value Status Yes FC
CPU 11/21 Memory Areas
Memory Areas in addition to general memory areas.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
DM 0 3071 Yes No Yes
DM 6144 6655 Yes No Yes

Specia addresses. CLOCK, MODE.
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CPU 51 Memory Areas
Memory Areasin addition to general memory areas.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
DM 0 6655 Yes No Yes
Specia addresses. CLOCK, MODE.
CPU 61 Memory Areas
Memory Areasin addition to general memory areas.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
DM 0 6655 Yes No Yes
EM 0 6143 * 1 Yes No Yes
Specia addresses. CLOCK, MODE.
CS1G Device Group
General Memory Areas
General Memory Areasfor all CPUs 42, 43, 44 and 45.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
IR 0 15 Yes (double) No Yes
DR 0 15 Yes No Yes fc
TK 0 31 Status Yes No
A 0 447 Yes Yes No
A 448 959 Yes Yes Yes fc
H 0 511 Yes Yes Yes
W 0 511 Yes Yes Yes
ClO(opt) 0 6143 Yes Yes Yes fc
T 0 4095 Present Value Status Yes FC
C 0 4095 Present Value Status Yes FC
D 0 32767 Yes No Yes
CF 0 11 No Yes No
CF 100 104 No Yes No
CF 113 114 No Yes No
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CPU 44 Memory Areas
Memory Areasin addition to General Memory Aress.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 *1 Yes No Yes -n
CPU 45 Memory Areas
Memory Areas in addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 * 3 Yes No Yes -n
Special addresses: (all CPUs): CLOCK, MODE.
(CPU 44/45): BANKNO.
CS1G-H Device Group
General Memory Areas
General Memory Areasfor all CPU 42, 42, 44 and 45
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
CIO(opt) 0 6143 Yes Yes Yes fc
DR 0 15 Yes No Yes fc
TK 0 31 Status Yes No
A 0 447 Yes Yes No
A 448 959 Yes Yes Yes f
H 0 511 Yes Yes Yes FC
W 0 511 Yes Yes Yes
T 0 4095 Present Value Status Yes FC
C 0 4095 Present Value Status Yes FC
D 0 32767 Yes No Yes
IR 0 15 Yes (double) No Yes
CF 0 11 No Yes No
CF 100 104 No Yes No
CF 113 114 No Yes No
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CPU 42 Memory Areas
Memory Areasin addition to General Memory Areas

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*1 Yes No Yes -n
CPU 43 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*1 Yes No Yes -n
CPU 44 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*1 Yes No Yes -n
CPU 45 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*3 Yes No Yes -n
CS1H Device Group
General Memory Areas
General Memory Areasfor all CPUs 63, 64, 65, 66 and 67.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
IR 0 15 Yes (double) No Yes
DR 0 15 Yes No Yes fc
TK 0 31 Status Yes No
A 0 447 Yes Yes No
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Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
A 448 959 Yes Yes Yes fc
H 0 511 Yes Yes Yes
W 0 511 Yes Yes Yes
ClO(opt) 0 6143 Yes Yes Yes fc
T 0 4095 Present Value Status Yes FC
C 0 4095 Present Value Status Yes FC
D 0 32767 Yes No Yes
CF 0 11 No Yes No
CF 100 104 No Yes No
CF 113 114 No Yes No
CPU 64 Memory Areas
Memory Areasin addition to General Memory Aresas.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 *1 Yes No Yes -n
CPU 65 Memory Areas
Memory Areasin addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 *3 Yes No Yes -n
CPU 66 Memory Areas
Memory Areas in addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767 * 7 Yes No Yes -n
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CPU 67 Memory Areas
Memory Areasin addition to General Memory Aress.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32765 * 13 Yes No Yes -n
Special (all CPUs): CLOCK, MODE.
addresses: (CPU 64/65/66/67): BANKNO.
CS1H-H Device Group
General Memory Areas
General Memory Areasfor all CPU 63, 64, 65, 66 and 67
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
CIO(opt) 0 6143 Yes Yes Yes fc
DR 0 15 Yes No Yes fc
TK 0 31 Status Yes No
A 0 447 Yes Yes No
A 448 959 Yes Yes Yes fc
H 0 511 Yes Yes Yes fc
w 0 511 Yes Yes Yes
T 0 4095 Present Value Status Yes FC
C 0 4095 Present Value Status Yes FC
D 0 32767 Yes No Yes
IR 0 15 Yes (double) No Yes
CF 0 11 No Yes No
CF 100 104 No Yes No
CF 113 114 No Yes No
CPU 63 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*1 Yes No Yes -n
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CPU 64 Memory Areas

Memory Areasin addition to General Memory Areas

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*1 Yes No Yes -n
CPU 65 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*3 Yes No Yes -n
CPU 66 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*7 Yes No Yes -n
CPU 67 Memory Areas
Memory Areasin addition to General Memory Areas
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
E 0 32767*13 Yes No Yes -n
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IDSC Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 27 Yes Yes Yes FC
DM 0 1023 Yes No Yes
DM 6144 6655 Yes No Yes
HR 0 99 Yes Yes Yes FC
IR (opt) 0 243 Yes Yes Yes FC
LR 0 63 Yes Yes Yes FC
SR (opt) 244 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
TC 0 511 Present Value Status Yes FC
Specia addresses. CLOCK, MODE.
SRM1 Device Group
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 15 Yes Yes Yes FC
DM 0 2047 Yes No Yes
DM 6144 6655 Yes No Yes
HR 0 19 Yes Yes Yes FC
IR (opt) 0 23 Yes Yes Yes FC
IR (opt) 200 252 Yes Yes Yes FC
LR 0 15 Yes Yes Yes FC
SR (opt) 232 252 Yes Yes Yes FC
SR (opt) 253 255 (bit 7) Yes Yes No
TR 0 0 (bit 7) No Yes No
TC 0 127 Present Value Status Yes FC

Specia addresses: MODE.
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SRM1 V2 Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
AR 0 15 Yes Yes Yes FC
C 0 127 Yes Yes Yes FC
DM 0 2047 Yes No Yes
DM 6144 6655 Yes No Yes
HR 0 19 Yes Yes Yes FC
IR 0 23 Yes Yes Yes FC
IR 200 239 Yes Yes Yes FC
LR 0 15 Yes Yes Yes FC
SR 240 253 Yes Yes Yes FC
SR 253 254 Yes Yes No
SR 254 255 Yes Yes No
TR 0 0 (bit 7) No Yes No
TC 0 127 Present Value Status Yes FC
Specia addresses: MODE.
CV1000 Device Group
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
A 0 255 Yes Yes Yes FC
A 256 511 Yes Yes No
AC 0 2047 No Yes No
C 0 1023 Present Value Status Yes FC
CIO (opt) 0 2555 Yes Yes Yes FC
D 0 24575 Yes No Yes
DR 0 2 Yes No Yes
G 0 255 Yes Yes Yes FC
IR 0 2 Yes No Yes
ST 0 1023 Yes Yes Yes
T 0 1023 Present Value Status Yes FC
TN 0 1023 No Yes Yes FC
TR 0 0 (bit 7) No Yes Yes FC
E 0 32765 * 2/4/8 Yes No Yes -n

Specia addresses: BANKNO, CLOCK, MODE.
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CV2000 Device Group

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
A 0 255 Yes Yes Yes FC
A 256 511 Yes Yes No
AC 0 2047 No Yes No
C 0 1023 Present Value Status Yes FC
CIO (opt) 0 2555 Yes Yes Yes FC
D 0 24575 Yes No Yes
DR 0 2 Yes No Yes
G 0 255 Yes Yes Yes FC
IR 0 2 Yes No Yes
ST 0 1023 Yes Yes Yes
T 0 1023 Present Value Status Yes FC
TN 0 1023 No Yes Yes FC
TR 0 0 (bit 7) No Yes Yes FC
E 0 32765 * 2/4/8 Yes No Yes -n
Specia addresses: BANKNO, CLOCK, MODE.
CV500 Device Group
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
A 0 255 Yes Yes Yes FC
A 256 511 Yes Yes No
AC 0 1023 No Yes No
C 0 511 Present Value Status Yes FC
CIO (opt) 0 2555 Yes Yes Yes FC
D 0 8191 Yes No Yes
DR 0 2 Yes No Yes
G 0 255 Yes Yes Yes FC
IR 0 2 Yes No Yes
ST 0 511 Yes Yes Yes FC
T 0 511 Present Value Status Yes FC
TN 0 511 No Yes Yes FC
TR 0 0 (bit 7) No Yes Yes FC

Specia addresses: MODE, CLOCK
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CVML1 Device Group

General Memory Areas

Memory Areas for any CPU.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
A 0 255 Yes Yes Yes FC
A 256 511 Yes Yes No
DR 0 2 Yes No Yes
CIO (opt) 0 2555 Yes Yes Yes FC
G 0 255 Yes Yes Yes FC
IR 0 2 Yes No Yes
TR 0 0 (bit 7) No Yes Yes FC
CPU 01 Memory Areas
Memory Areasin addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
C 0 511 Present Value Status Yes FC
D 0 8191 Yes No Yes
T 0 511 Present Value Status Yes FC
CPU 11 Memory Areas
Memory Areasin addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
C 0 1023 Present Value Status Yes FC
D 0 24575 Yes No Yes
T 0 1023 Present Value Status Yes FC

Specia addresses:. (all CPUs): CLOCK, MODE.
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CVM1-V2 Device Group

General Memory Areas

Memory Areas for any CPU.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
A 0 255 Yes Yes Yes FC
A 256 511 Yes Yes No
DR 0 2 Yes No Yes
CIO (opt) 0 2555 Yes Yes Yes FC
G 0 255 Yes Yes Yes FC
IR 0 2 Yes No Yes
TR 0 0 (bit 7) No Yes Yes FC
CPU 01 Memory Areas
Memory Areasin addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
C 0 511 Present Value Status Yes FC
D 0 8191 Yes No Yes
T 0 511 Present Value Status Yes FC
CPU 11 Memory Areas
Memory Areasin addition to General Memory Aress.
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
C 0 1023 Present Value Status Yes FC
D 0 24575 Yes No Yes
T 0 1023 Present Value Status Yes FC
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CPU 21 Memory Areas
Memory Areasin addition to General Memory Aress.

Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
C 0 1023 Present Value Status Yes FC
D 0 24575 Yes No Yes
T 0 1023 Present Value Status Yes FC
E 0 32765 * 2/4/8 Yes No Yes -n
Special (all CPUs): CLOCK,
addresses: (CPU 21): MODE.
BANKNO.
FinsGateway CPU Unit
Prefix Start End Channel Word Bit Read Modifiers
Channel Addressing Addressing Write
ClO(opt) 0 32767 Yes Yes Yes
D 0 32767 Yes No Yes

Revision 1.7

Page 87




OMRON

APPENDIX C- Toolbars and Keyboard Shortcuts

APPENDIX C

Toolbars and Keyboard Shortcuts

The following tables summarise the toolbars and keyboard shortcuts available from each component
and tool. The F1 function key is common across all components and tools and provides context help.

Project Editor

Toolbar

Up One Level

Add PLC
Add Group
Add Point

Cut
Copy

Paste

X |B|& = |T|0E |F

Delete

=]
=

Rename

B

Properties

Large Icons

| Small Icons

List

Details

Keyboard Shortcuts

Delete
Alt+F4
Ctrl+X
Ctrl+C
Ctrl+Vv
Ctrl+A
F5

Ctrl+F

Delete
Close
Cut
Copy
Paste
Select All
Refresh
Find
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GLOSSARY OF TERMS

Actual 10 Table
Address

Application

Baud rate

BCD
Binary

Bit

Bus

Command modifier

Components
Controller Link
CPU type

CPU
CVSS

The real hardware configuration of the PLC units and slots on power-up.

A location in memory where data or programs are stored. It can also
identify alocation of a node on a network.

A software program that accomplishes a specific task. Examples of
applications are CX-Server, CX-Programmer, CX-Protocol and Microsoft
Excel.

The speed of data transmission in terms of the number of bits per second
that are being sent.

Binary Coded Decimal.

A data format supported by CX-Server. A number system format to the
base 2, i.e. employingthedigitsOand 1.

A digit used in binary notation which can take the value 0 or 1. The value
of abit, or combination of bits, can represent the status of a device or can
be used in programming.

A communications path along which data can be transmitted or received
between the units connected to it.

An optional part of an address string indicating the modification to be
performed on the data at that address (within PLC memory) when it is
accessed.

CX-Server is made up of six components accessible from an invoking
application.

A network that can send and receive large data packets flexibly and easily
among the OMRON PLCs.

The type of CPU available to a specific device, the amount of memory
available to a PLC varies according to the CPU involved.

Central Processing Unit.

A file format supported by the CX-Server Import tool. CVSS has several
file types which have different information contained in them.

CX-Net Network Configuration tool

CX-Server

CX-Server Project

This CX-Server tool consists of a suite of programs allowing the
management of Routing Tables and Data Link Tablesin OMRON PLCs.

An advanced communications management system for OMRON PLCs
providing facilities for software to maintain PLC device and address
information and to communicate with OMRON PLCs and their supported
network types. CX-Server supports CS1-series PLCs.

A definition of an OMRON PLC network configuration. It identifies all
devices and networks within a particular configuration including the areas
of PLC memory (points) that can be read from or written to.
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Data area
Data bits
Data link

Data link table

Data location
DDE

DDE management library
DDE Manager tool

DDEML
Default

Device group

Devicetype
Device

Dialog

DLL

Double Floating Point

Download
Drag

An area of PLC memory allocated to the storage of data (not programs).
Bits representing each character to be transmitted.

A software connection establishing common data areas between PLCson a
network allowing data to be between these devices.

A table of the common data memory areas used by the PLCs in a Data
Link.

An area of memory identified by an address.

Dynamic Data Exchange. A channel through which correctly prepared
programs can actively exchange data and control other applications within
Microsoft Windows. CX-Server, through the use of the DDE Manager
tool, allows extensive use of DDE functionality.

See also Item, Server, server application and Topic.

A dynamic link library within Windows which alows dynamic data
exchange to be employed.

A CX-Server tool for allowing transferral of data between PLCs and a
client application using DDE, for example Microsoft Excel.

Dynamic Data Exchange Management Library.

A value automatically set by a program in the absence of user input or on
initial entry to an application; such values can be overwritten.

A class of devices which share similar properties, each group can be sub-
divided into device types.

A type of OMRON PLC.

A type of OMRON automation device, either a PLC, Temperature
Controller, Memory Card Writer or PROM Writer.

A window asking for some form of response from the user, usually in the
form of either entering requested information, selecting displayed data, or
confirming an operation.

Dynamic Link Library. A program file that although cannot be run stand-
alone as an executable, can be utilised by one or more applications or
programs as a common service. DLL files have a *.DLL extension.
DLL’s comprise a number of stand-alone functions.

Double Floating Point (LREAL) type is as the IEEE754 Double precision
(1.7E +308/-307) as defined by Microsoft®.

Refer to Transfer to PLC.

The act of moving an item on the screen by selecting it with the mouse,
and keeping the mouse button depressed, moving the mouse until the item
has reached the required location. The mouse button is then released.
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Driver

Dynamic Data Exchange

EEPROM
Elements
End Connection

The software which controls the communications between a computer and
PLC, trandating any information passed between them into a format that
the receiving Device can understand.

The method of transferral of data (and possibly instructions) between
applications via the establishment of reference links between them.

Electrically Erasable Programmable Read Only Memory.
The number of address units which start at a specified data location.

The final communication link between computer and PLC, or in the case of
a Network configuration, gateway PLC to PLC.

Ethernet A 10 MB baseband local area network with each Device attached to the
network having equal status and therefore the ability to transmit as, and
when, required (provided the line isn’t busy).

Even parity The number of 1sin adatatransmissionis even.

Expansion memory The memory available to a CPU in addition to conventional memory.

File memory An area of CPU memory allocated to the storage of data.

FINS Factory Intelligent Network Service.

FinsGateway An OMRON communication type supported by CX-Server.

Floating Point A dataformat supported by CX-Server.

Folder A structure which organises the filesin computer memory or on disk. Also
known as a ‘directory’.

Framelength The waiting time before data is transmitted across the network

Gateway device A Device connecting two networks of different architectures together.

Gateway PLC A PLC which acts as alink to another network.

Group A sub-directory within a CX-Server project hierarchy which contains
points and/or further (subsidiary) groups.

Hard disk A disk permanently mounted on its drive.

Hierarchy The structure of a CX-Server project from the root directory down through
any sub-directories (groups) to individual points contained within those
groups.

Host link unit The interface between a PL C and a host computer.

Icon Pictorial representations of computer resources and functions. Many icons
are used by CX-Server components and tools as part of the GUI.

IDSC devicetype An OMRON PLC device supported by CX-Server.

Import tool This CX-Server tool is used for addresses and PLCs defined using the
CVSSand LSS products.

Input The signal sent to a PLC from an external device.

Instruction A statement indicating an operation to be performed and identifies any data
involved in this operation.
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Intel Hex
Interface

Internal datatype
Invoking application
IO Table component

10

IP addresstable
| P address

IP

Item

LAN

Link system
Link unit

Link

L oad
LREAL

LSS

Mb

Memory area

Memory Card Writer
Memory card

MHz

Microsoft Excel

Microsoft Windows Explor er
Microsoft Windows

A PLC device also known as a PROM Writer.

Hardware or software employed to link the elements within a system,
including networks, programs and computers.

The format of the data held at an address in PLC memory; for example, bit
or signed character binary.

An application such as CX-Programmer and CX-Protocol that utilises
components and tools belonging to CX-Server.

This CX-Server component retrieves configured PLCs rack and address
data.

Input /Output.

A table containing the | P addresses for all the devices on the Ethernet.
An address for a device on the Ethernet.

Internet Protocol.

A unique name for a dataitem within atopic.

Local Area Network.

A system that links PL Cs together.

A unit which connects a device to the network.

A connection between two units established either by software or a
hardware device.

Placing a program or data into an area of computer or PLC memory.

LREAL (Double Floating Paint) type is as the IEEE754 Double precision
(1.7E +308/-307) as defined by Microsoft®.

A file format supported by the CX-Server Import tool.
Megabites— A means of defining computer memory size.
Addressable area of storage space in a device.

A device which writes datato a memory card.

A data storage medium which can hold both programs and data.
Megaherts.

A spreadsheet application.

A file handling application part of the Microsoft Windows suite.

A windowing environment that is noted for its GUI, and for features such
as multiple typefaces, desk accessories (such as a clock, calculator,
calendar and notepad), and the capability of moving text and graphics from
one application to another via a clipboard.

CX-Server runs only under Microsoft Windows. DDE functions
communicating with other applications supported by CX-Server use
Microsoft Windows as a basis.
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M odem

n
Network Service Board
Networ k

Node number

Node

NSB

Offline

OLE

Online
Output
Packet

Parity

Path

Peripheral

Perfor mance M onitor tool

Ping test
PLC Error component

A device with the ability to convert digital data from a computer into
analogue form and transmit it over a telecommunications line and aso to
convert received analogue signalsinto digital form.

A variable number.
An interface which connects devices (not PL Cs) to the network.

1. Part of the PLC configuration, based on the device type. The number
of Networks available is dependant on the device type.

2. A number of computers linked together with a central processing point
known as a Server which is accessible to all computers. Networks
affect CX-Server in that further Network associated options are
available if the computer is Network connected.

Number identifying the device located at a particular node on the network.

The number can be between 1 and 126, the maximum number of nodes

available on an OMRON network.

A position at which a device can be located on the network, consisting of a

link unit mounted to a device or PLC which in turn interfaces with a

peripheral device or acomputer.

Network Service Board.

The status of a device when it is not being controlled by a computer

(although it may be physically connected to it).

Object Linking and Embedding. Used to transfer and share information

between Microsoft Windows based applications and accessories.

The status of a device when it is under the direct control of acomputer.

The signal sent from a PLC to an external device.

A unit of information transmitted across the network containing source and
destination address information together with the actual data.

A type of validation check performed on transmitted information; data can
be tested for either even, odd, none, mark or space parity. The type of
parity check involved isindicated by the status of the parity bit.

The location of a file including the drive, directory name plus any
subdirectories and the file name together with its associated extension.

A device which aids system operation rather than being centra to its
functioning.

A CX-Server tool for monitoring communications throughput and for
displaying CX-Server’s current performance level (i.e. acheck to seeif
CX-Server is becoming overloaded).

A standard Ethenet communications test.

This CX-Server component displays and manages PLC errors.
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PLC Memory component

PLC Setup component
PLC
Point

Port

Program
Program memory
Program mode

This CX-Server component allows the user to view, edit and monitor either
channels (words) or individual bitsin areas of the PLC.

This CX-Server component permits the configuration of PLC settings.
Programmable Logic Controller.

A point is used to hold a value of a predefined type - Boolean, Integer,
Text, etc. The contents of a point may be controlled by an object or 1/0
mechanism such as DDE. The contents of a point may control the action
or appearance of an object, or be used for output via an I/O mechanism.

A device connection point allowing data entry and exit.

A set of instructions which are performed by a computer or PLC.

An area of PLC memory reserved for the storage of programs.

PLC mode of operation during which the device can be programmed.

Programmable Read Only Memory

Proj ect

PROM writer
PROM

Protocol

Rack

RAM

Registered 10 Table

Root

Root group
Rotary switch
Routing table

Routing
RS232
R$422

Serial Connection

An area of memory which can be updated with programs and data only
once after manufacture; once this area has been written to, it can only be
read, not modified.

OMRON configuration file inherited from the invoking application.
Refer also to CX-Server Project.

A device which writes the programs and datainto PROM .
Programmable Read Only Memory.

A set of rules governing the transmission of data.

The apparatus to which a unit is fixed.

Random Access Memory.

The internal PLC table: this is the one used by the PLC when running,
regardless of the state of the actual hardware. It can be read and, for CV-
series PLCs, written to by the CX-Server software.

The highest level of adirectory.
The highest level group in a CX-Server project.
Indicates the method of calling a device by generating a series of pulses.

A table containing the information necessary to allow communications
between different networks including local and gateway network address
details.

The direction of data across a network from its source to its destination.
Industrial interface standard for serial communications.

Industrial interface standard for serial communications employing balanced
line circuits.

A direct connection between computer and PLC.
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Server 1. Server is used in DDE functions to contain a link to an outside
application. Using DDE functions, CX-Server alows the manipulation
of an outside application as specified as the Server.
Refer also to Server application.

2. A Server is the central processing point of a Network which is
accessible to all computers. Networks affect CX-Server in that further
associated options are available if the computer Network is connected.

Slots Free areas within arack to which units can be fixed.

Stop bits Bits indicating the end of transmission of each set of data bits; normally
one or two bits, they indicate the delay time between sending successive
characters down the line.

Symbol An address that has been given a name to make the address information
more flexible. Symbols are inherited by CX-Server by the invoking
application.

SYSMAC LINK OMRON high speed industrial network (either co-axial or fibre optic).

SYSMAC NET OMRON high speed optical LAN which can be of type C SYSMAC NET
or CV SYSMAC NET.

SYSMAC WAY OMRON network.

System area An area of memory used for controlling and managing a unit.

System configuration An arrangement of units, for example network, computers and PLCs.

Tagged database A file format supported by the CX-Server Import tool. The Tagged
database is also an export format of the CX-Server Import tool.

Target PLC The PLC to which information or instructions are directed.

Taskbar An integral part of Microsoft Windows which allows Microsoft Windows
based applications to be started. CX-Server tools are run from the Taskbar.

TCP/IP Transmission Control Protocol/Internet Protocol.

Temperature Controller An OMRON device.

Temporary Relay Area An area of PLC memory containing instructions which can be loaded at a
later point for use with other instructions.

Text 1. Afileformat supported by the CX-Server Import tool. The Text isaso

an export format of the CX-Server Import tool.

2. A dataformat supported by CX-Server.

Timer area An area of PLC memory containing program timers and their related
completion flags.

Toolbus A network, either C-Toolbus or CV-Toolbus, allowing communications
with a device via the seriadl COM port of a personal computer (in a similar
manner to SYSMAC WAY). Data is transmitted along the network in
binary format.

Tools CX-Server is made up of four tools.
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Transfer from PLC
Transfer toPLC

UDP
Unit number

Units
User Datagram Protocol

Word

The transfer of a program or data to a host (either a computer or a
programming device) from alower-level (or ave) device.

The transfer of a program or data from a host (either a computer or a
programming device) to alower-level (or slave) device.

User Datagram Protocol.

A number identifying an individual component of an OMRON PLC system
configuration.

A component of an OMRON PLC system configuration.

Protocol which directs information across a network to port numbers rather
than to | P addresses.

A 16 bit unit of data memory.
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INDEX

Network connections - 28

Network settings - 26

A Nodes - 29

PLC-SeePLC

PLC seria network configuration - 28

About CX-Server - 1, 6, 89

About this Manual - 4 PROM Writer - 35
Access . Requirements - 4
Change PLC dialog - 22 Routing tables - See Routing tables
DDE Manager tool - 5, 45 Serial connection - 26
Edit Project dialog - 39 Supported communications - 21
Import/Export tool - 5, 38 SYSMAC LINK -23. 33
Performance Monitor tool - 5, 51 SYSMAC NET - 23 '33
Project editor - 14 SYSMAC WAY - 23
Adding aDevice - 19 SYSMAC WAY with Modem - 23
AppendixA Toolbus - 23
Network Availability - 53 Toolbus with Modem - 23
Appendix B Controller Link

PLC Memory Areas - 61 Communications - 23, 34
Appendix C Network settings - 34
Toolbars and Keyboard Shortcuts - 87 Copying a Point Link - 47
Application - 89 Customer support for CX-Server - 7
Automatic versus Manual Updates - 48 CX-Net Network Configuration tool
Ping test - 93
B CX-Server
About - 1, 6, 89
Baud rate - 89 Customgr support - 7
Bit - 89 Installation - 4
Projects - See CX-Server project
Starting - See Access
C System requirements - 3
CX-Server 1.5 Fearures - 2
Communications - 21 CX-Server project - 9
Connection possibilities - 25 Access Project editor - 14
Controller Link - 23, 34 Closing Project editor - 15
CS1-Series connection options - 32 Concepts - 9
C-Series connection options - 30 Creating anew CX-Server project - 38
CV-series connection options - 31 Device List dialog - 11
Datalink tables - See Data Link tables Edit project dialog - 13, 14
DIP switches - 26 Editing a CX-Server project - 13, 39
Direct connection - 26 Editing PLC list - 11
End connections - 28, 91 Groups - 13
Ethernet - 23, 34 Import files - 37
FinsGateway - 29 Introduction - 9
FinsGateway CPU - 23 Opening an existing CX-Server project - 39
Gateway connections - 23, 25 PLC - SeePLC
Link adapters - 26 Points - See points
Modem - 23, 92 Project editor - 13
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Project editor, Access - 14 Tagged databasefiles - 42
Project editor, Close - 15 Text files - 42
Saving a CX-Server project - 39
CX-Server Project Selection - 38
CX-Server Software - 1 G
D Glossary of Terms - 89
DDE - 45, 90, 91 H
Automatic updates - 48 )
Copying apoint link - 47 Help - See Onlinehelp
Defining alink - 46 Help and how 10 accessit - 5
Defining update intervals - 49 Help topics - 5
Establishing connection - 45 Help topics
Item - 46, 92 Find -6
Manual updates - 49 Index - 5
Server - 46, 94 Help Topics
Topic - 46 Context sensitive help - 6
DDE Manager tool
Access - 5, 45 |
Automatic updates - 48
Close-45 Import - 39
Copying apoint link - 47 CVSSfiles - 38, 39
Defining alink - 46 CX-Server projects - 37
Defini ng _update |ntervals -49 FinsServer files - 38, 40
Establlsh! ng connection - 45 LSSfiles- 38, 40
Introduction - 45 Projects - 37
Item - 46 Tagged database files - 38, 40
Manual updates - 49 Text files - 38, 40
Server - 46 Import/Export tool
Topic - 46 Access - 5, 38

DDE Manager Tool - 45
Defining aLink - 46
DeviceNet - 29

Access theEdit Project dialog - 39
Clearing the display - 37

! Close - 38
Devices - See PLC . Creating anew CX-Server project - 38
Differences between DeviceNet Network as FINS CVSSimport - 38, 39

Network and other PLC Networks - 29

. Editing a CX-Server project - 39
DIP switches - 26

FinsServer export - 42

DLL -90 FinsServer import - 38, 40
Introduction - 37
E LSS import - 38, 40
Opening an existing CX-Server project - 39
Establishing DDE Links - 45 Printing the display - 39
Ethernet Saving a CX-Server project - 39
Communications - 23, 34 Statusbar - 37
Network settings - 34 Tagged database file export - 42
Export - 41 Tagged database file import - 38, 40
FinsServer files - 42 Text export - 42
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Text import - 38, 40
User interface - 37
Import/Export Tool - 37
Index - 97
Installing CX-Server - 4
Intriduction to CX-Server Projects - 9
10 Table component
Actual |0 Table - 89

Device name - 9

Device setup - 21

Devicetype - 10, 22

Device type settings - 24

Editing CX-Server Project PLC list - 11
Network type - 22

RenamingaPLC - 13

Serial network configuration - 28

Registered 10 Table - 94 Settings - 21
PLC Memory Arears - 61
Points - 10
L Adding agroup - 15
) Adding apoint - 16
Link adapters - 26 Adding multiple points - 17
Address - 10, 89
N Command modifier - 17, 89
Comment - 10
Network Availability - 53 Copy - 18
Notice - 2 cut-18
Datalocation - 16, 90
Deleting agroup - 18
O Deleting apoint - 18
Editing apoint - 18
Onlinehelp - 2,5 Elements - 16
Groups - 13,91
Internal datatypes - 17
P Moving agroup - 18
. Moving apoint - 18
Performance Monitor tool Name - 10
Access - 5, 51 Paste - 18
Close - 51 PLC-16
Introduction - 51 Preferences - 15
User interface 52 Renami ng agroup - 16
Performance Monitor Tool - 51 Print

PLC-9
Access Change PLC didog - 22
AddingaPLC - 12, 19
Change PLC dialog - 22
Changing PLC settings - 22
Comment - 9
Connection options - 10
Connection type - 10
Connection type options - 10
CS1-Series connection options - 32
C-Series connection options - 30
CV-Series connection options - 31
DeletingaPLC - 12
DeviceListdiadog - 11

Import/Export tool - 39

Product References - 2

Projects - See CX-Server project. For non-CX-Server
projects, refer to the user manual for the invoking
application.

PROM Writer
Communications - 35

R

Racks - 94
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S

Slots - 95
Specia Data Types - 49
Starting CX-Server - See access
Status bar - 6
Import/Export tool - 37
Project editor - 14
Supported Import/Export Data - 38
Symbols - 95
SYSMAC LINK
Communications - 23, 33
Network settings - 33
SYSMAC NET
Communications - 23, 33
Network settings - 33
SYSMAC WAY
Communications - 23, 26
Modem communications - 23, 26
Network settings - 27
System requirements - 3

T

Table of Contents - 5
Technical Specification - 1
Toolbars and Keyboard Shortcuts - 87
Toolbus
Communications - 23, 27
Modem communications - 23
Network settings - 27

U

Units - 96

V

Visud Aids -3

W

Words - 96
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